The present version of this manual refers to using the microprocessor card v. 3. With an earlier version of the card, version 1.1.4 of the manual should be used.

The last version of this manual can be downloaded from: [www.sensaqua.com/download](http://www.sensaqua.com/download)
Table of Contents

DECLARATION OF CONFORMITY ................................................................................. 3
ABOUT THIS MANUAL ................................................................................................ 4
1 PRODUCT DESCRIPTION .......................................................................................... 4
  1.1 Introduction ........................................................................................................ 4
  1.2 What is new in the ATMS 600v3 and the LTMS 600v3 series? ......................... 6
2 METHOD ..................................................................................................................... 8
  2.1 General aspects and background ..................................................................... 8
  2.2 Electrochemical analysis .................................................................................. 9
    2.2.1 Principles of Voltammetry ......................................................................... 9
    2.2.2 The voltammetric cell system ................................................................ 10
      2.2.2.1 Working Electrode (WE) .................................................................. 10
      2.2.2.2 Reference Electrode (RE)................................................................. 11
    2.2.3 Auxiliary (counter) Electrode (CE) .......................................................... 11
    2.2.4 Supporting electrolyte and gas purging ..................................................... 11
  2.3 Pulse Voltammetry and Square Wave Voltammetry ........................................ 11
    2.3.1 Differential Pulse Voltammetry ................................................................ 11
    2.3.2 Square Wave Voltammetry ..................................................................... 12
  2.4 Stripping Voltammetry ...................................................................................... 13
    2.4.1 Differential Pulse Anodic Stripping Voltammetry (DPASV) and Square Wave
         Anodic Stripping Voltammetry (SWASV) ..................................................... 13
      2.4.1.1 Deposition Step ................................................................................ 13
      2.4.1.2 Stripping Step .................................................................................. 14
  2.5 Some literature references about voltammetry ................................................. 14
3. SYSTEM OVERVIEW ............................................................................................... 15
  3.1 Description of the ATMS system .................................................................... 15
  3.2 Technical Specifications .................................................................................. 16
4 INSTALLATIONS ...................................................................................................... 17
  4.1 Location and field installation ....................................................................... 17
  4.2 Electrodes and measuring cell ....................................................................... 19
  4.3 Electrical connections ..................................................................................... 19
  4.4 Software installation ....................................................................................... 19
  4.5 Connecting to Internet .................................................................................... 20
5 POS SOFTWARE; OPERATING INSTRUCTIONS .................................................... 20
  5.1 What is POS? ..................................................................................................... 20
  5.2 System Requirements ....................................................................................... 20
  5.3 POS Software Setup ........................................................................................ 20
    5.3.1 Checking the SensAqua Sensor (SA Sensor) ............................................ 22
    5.3.2 Setting up Scan profile ............................................................................ 23
    5.3.3 Setting up Metal Definition Table ............................................................ 26
    5.3.4 Calibration (see also chapter 7.1) ............................................................. 27
    5.3.5 Starting a Scan ......................................................................................... 28
    5.3.6 Analyzing a Scan .................................................................................... 28
    5.3.7 Automatic measurement (see also chapter 7.2) ....................................... 28
    5.3.8 Automatic measurement sequence ......................................................... 30
5.4 Communication Setup ........................................................................................................... 31
6 SERVICE INSTRUCTIONS .......................................................................................................... 35
   6.1 Start-up inspection ............................................................................................................. 36
   6.2 Periodical maintenance ................................................................................................... 36
   6.3 Procedure for maintaining the cell and electrode system ............................................... 37
   6.4 The microprocessor card ................................................................................................. 41
   6.5 Troubleshooting .............................................................................................................. 41
   6.6 Security ............................................................................................................................ 42
7 CALIBRATION AND RUNNING SETUP - EXAMPLES ............................................................. 42
   7.1 Calibration setup ............................................................................................................ 42
   7.2 Running setup .................................................................................................................. 47
8 APPLICATION NOTES FOR SOME COMMON METALS IN WATER ...................................... 64
   Application note ATMS-Cd\textsuperscript{Sens} ........................................................................... 65
   Application note ATMS-Pb\textsuperscript{Sens} ............................................................................ 66
   Application note ATMS-Zn\textsuperscript{Sens} ........................................................................... 66
   Application note ATMS-Fe\textsuperscript{Sens} ........................................................................... 66
   Application note ATMS-Bi\textsuperscript{Sens} ............................................................................ 67
   Application note ATMS-Tl\textsuperscript{Sens} ............................................................................. 67
   Application note ATMS-Mn\textsuperscript{Sens} ............................................................................ 67
   Application note ATMS-Cu\textsuperscript{Sens} ........................................................................... 68
   Application note ATMS-Hg\textsuperscript{Sens} ........................................................................... 68
   Application note ATMS-Ni\textsuperscript{Sens} ............................................................................ 68
   Application note ATMS-Co\textsuperscript{Sens} ............................................................................ 69
   Application note ATMS-Cu/Fe/Zn\textsuperscript{Sens} - automatic monitoring in a river system .......... 69
9. Assembling of the ATMS 600 v3 and the LTMS ................................................................. 70
10 OPTIONS ................................................................................................................................ 75
   10.1 Output of 4 - 20 mA .................................................................................................... 75
   10.2 Warning systems .......................................................................................................... 75
A APPENDICES .......................................................................................................................... 75
   A.1 Quick start up guide for the ATMS 600 and the LTMS 600 ........................................ 75
   A.2 Calculations .................................................................................................................. 76
   A.3 Remote control .............................................................................................................. 77
   A.4 Flow data for the peristaltic pump 400/F/M1 (W-M Alitea) .......................................... 78
   A.5 Wiring changes of the ATMS Flat 20-cable connection ............................................... 78
      A.5.1 Flat 20-cable connection from the 26-pin plug, dual cell version, valid for installations before July 2014 ................................................................. 78
      A.5.2 From the 26-pin plug after July 2014, but before March 2016: ............................. 79
      A.5.3 After 1. March 2016: ............................................................................................. 80
   A.6 Troubleshooting without the card present (also see Chapter 9) .................................. 82
   A.7 LTMS with a v.2 card ..................................................................................................... 82
DECLARATION OF CONFORMITY

We, SensAqua AS
of Næringshagen, NO-7340 Oppdal, Norway
in accordance with the following Directive
Hereby declare that the Automatic Trace Metal System Model 600 (ATMS600) is in conformity with
the applicable requirements of the following documents

<table>
<thead>
<tr>
<th>Ref. No.</th>
<th>Title</th>
<th>Edition/date</th>
</tr>
</thead>
<tbody>
<tr>
<td>BS EN 61000-6-1</td>
<td>Electromagnetic compatibility (EMC) Generic standards. Immunity for residential, commercial and light-industrial environments</td>
<td>2001</td>
</tr>
<tr>
<td>BS EN 61000-6-3</td>
<td>Electromagnetic compatibility (EMC) Generic standards. Emission standard for residential, commercial and light-industrial environments</td>
<td>2001</td>
</tr>
</tbody>
</table>

I hereby declare that the equipment named above has been designed to comply with the relevant sections of the above referenced specifications. The unit complies with all applicable Essential Requirements of the Directives.

The equipment is powered with 12 V DC, consequently the 2006/95/EC The Low Voltage Directive is not applicable. Any connection to higher voltage might be harmful for the equipment and the environment. If a 12 V DC adapter is used, this has to be marked with CE and ☐.

The equipment is designed for monitoring of pollutants in lakes, rivers, effluents, industrial processing etc., and not in domestic environment. This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

The approval of this product has been performed by the authorized organization NEMKO in Oslo, Norway (www.nemko.com/about/nemko-notified-body).

Signed

Knut Schröder
General Manager
SensAqua AS
On 18th February 2023
ABOUT THIS MANUAL

This manual is meant as a reference for users of the SensAqua Automatic Trace Metal System ATMS 600v3 series and the corresponding non-automatic Laboratory Trace Metal System LTMS 600v3 series. It contains information about installation, management and maintenance of the system.

Some background theory about general analytical chemistry and in particular voltammetry is reviewed. The manual does not require any previous knowledge, but it is advantageous to have some understanding of the basic principles of electrochemical analyzes.

Chapter 1. Product Description, gives a brief overview of the SensAqua Automatic Trace Metal System, its features and applications.

Chapter 2. Method gives a short introduction to analytical chemistry with voltammetry in general, with a specific view to stripping analysis.

Chapter 3. System overview gives a description of the ATMS system and its technical specifications.

Chapter 4. Installation, describes how to install the unit as well as details regarding installation of the software.

Chapter 5. POS software and Software operation, describes how to use the product and the control-and data acquisition-software.

Chapter 6. Service instruction, describes maintenance information.

Chapter 7. Some application notes for the most common metals in natural water.

1 PRODUCT DESCRIPTION

1.1 Introduction

SensAqua Automatic Trace Metal System (ATMS) is an instrument for detecting and measuring metals in water. The measurement principle is based on electrochemical voltage-current measurements (voltammetry). The Laboratory Trace Metal System (LTMS) is a similar, but non-automatic instrument for laboratory use.

Several analytical methods are available for monitoring of the environment and industrial processes. Most frequently used is atomic absorption spectrometry (AAS) and inductively coupled plasma mass spectrometry (ICP-MS). However, very few methods can be adapted for use on line in the field. The reason is that available methods are not sufficiently sensitive. Alternatives are frequently to bring samples to laboratories to be analyzed with sophisticated equipment. This is inconvenient, expensive and
gives an undesired time lag from the appearance of an accidental or illegal pollutant to the detection of it.

The present paper reports an online monitoring system for heavy metals in normal water, seawater, waste and process water. The system is fully automated, and can be set up for remote transfer of the results via Internet.

A great advantage is to carry out the measurements on-line and automatically with remote transfer of the results e.g. via Internet. However, because the concentrations of the actual metal ions are very low, sensitive and sophisticated instruments are required, rarely being suitable for remote operations in the field. The only suitable on-line analytical method being sufficiently sensitive for this purpose is voltammetry or related dynamic electroanalytical techniques. Use of automatically methods will also enable one to act immediately upon environmental accidents or illegal effluents.

Voltammetry has some advantages compared to other techniques. It is a fast and easy analytical technique to carry out. The instrument is inexpensive, and the operating costs are low. The possibility to construct voltammetric apparatus for online monitoring is good and they may be operate for several weeks or months without any maintenance. Also, voltammetric methods for metals have a good sensitivity, and the detection limit for many important heavy metals is in the range of 0.5 – 1 μg/L and even lower.

The introductions of solid amalgams and alloy electrodes have created new possibilities for constructing useful voltammetric apparatus for use in field with long-term measuring stability. It is now possible to construct apparatus with good stability over long periods of times for continuous remote surveillance of the level of heavy metals like e.g. nickel, zinc, cobalt, cadmium, thallium, copper and mercury in waters (rivers, drinking water, effluents etc.).

Some remarks about concentration, precipitation and speciation
The term “concentration” looks quite simple, but we need clarify what we mean with that term.

If we have a real solution of a heavy metal, in absence of precipitation (often invisible) or complexing reagents, the definition is clear; otherwise we have to define our system. If precipitates are present together with the solution, the system is not properly defined, and without a precipitate, we need to consider the actual chemical form (speciation) because the different species have different effect in the environment. Filtering is a way to find out if a solid is present.

Measurement of total concentration (like with AAS or ICP-MS) in a non-homogeneous water system will not be consistent because the results will depend on the accidental amount of the solid phase entering the measuring system. Our voltammetric method measures the electrolabile compound, this giving a picture being close to the bioavailability and toxicity.

An important natural purification process for heavy metal contaminated waters is the hydroxide and sulfide precipitation forming sediments. The solubility products of some compounds are as follows:

<table>
<thead>
<tr>
<th>Compound</th>
<th>Solubility Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>CdS</td>
<td>1.0 x 10^{-27}</td>
</tr>
<tr>
<td>CuS</td>
<td>8.0 x 10^{-37}</td>
</tr>
<tr>
<td>PbS</td>
<td>3.0 x 10^{-28}</td>
</tr>
<tr>
<td>TlS</td>
<td>6.0 x 10^{-22}</td>
</tr>
<tr>
<td>AgS</td>
<td>8 x 10^{-51}</td>
</tr>
<tr>
<td>ZnS</td>
<td>1.0 x 10^{-24}</td>
</tr>
<tr>
<td>FeS</td>
<td>8.0 x 10^{-19}</td>
</tr>
<tr>
<td>Cd(OH)₂</td>
<td>7.2 x 10^{-15}</td>
</tr>
<tr>
<td>Cu(OH)₂</td>
<td>4.8 x 10^{-20}</td>
</tr>
<tr>
<td>Pb(OH)₂</td>
<td>1.4 x 10^{-20}</td>
</tr>
<tr>
<td>Zn(OH)₂</td>
<td>3.0 x 10^{-17}</td>
</tr>
</tbody>
</table>

Obviously, the presence of any sulfide or a high pH-value will give precipitation and therefore non-consistent results might appear. Here we need to point out that this is not due to any weaknesses of the measuring method or the equipment being used, particularly this in the case with mercury, copper etc. Here we also have to consider a possible precipitation during a calibration.
1.2 What is new in the ATMS 600v3 and the LTMS 600v3 series?

The chemical principles for the ATMS 600 series and the previous ATMS 500 series are the same. This also means that the measuring cell and the electrode system are unchanged. The ATMS 500 uses 230 V AC and the ATMS 600 uses 12 V AC. The latter is advantageous if electricity is not available and solar cells or other sources are used.

The ATMS 500 consists of two cabinets, one for the electrode system and one for most of the electronics and the industrial PC to be used. All the data processing for the ATMS 500 is performed by using the PC.

In the ATMS 600 series, however, all the electronics is on a microprocessor card and a PC is not needed except from input and output of data and graphical presentation. Normally a laptop or network is used for such purposes. The ATMS 600 consists of one cabinet only, with the cell system and a metal enclosure with the microprocessor card inside.

An extension of the ATMS 600 is an ATMS using a dual measuring cell system, called ATMS 600D. This enables one sequentially to measure two systems using different experimental conditions.
The advantages with the ATMS 600, compared with previous models, are:

- Higher stability over time by using a microprocessor card instead of the PC-processor
- More simple maintenance because the card is the only to be replaced if needed
- Increased sensitivity also because Square Wave Voltammetry is included
- Less weight with one cabinet only
- No computer is needed except from input and output of data and data processing. For that purpose a laptop PC is included in the system, but this can be removed during running
- The use of 12 V DC is convenient if electricity is not available. If electricity is there, a simple adapter to 12 V DC can be used (charging of the laptop will not be needed during the short time inspection)

After the first ATMS600 was launched, it has been some upgrading of firmware, software and hardware, for better performance. The measuring cell is no longer drained by using a magnetic valve; a peristaltic pump is now used for that purpose. We have also moved the switch for regulating the supporting electrolyte to the 5th (unused) relay, this to obtain a galvanic shielding. Furthermore, we have opened for using two separate power supplies, one for the electronics and one for the pumps, stirrer etc. Normally this is not required and the unit can be connected to one power supply only. The present microprocessor card is version 3. This is redesigned for improved performance. If connected to the Internet, any new version of the software for the ATMS600 (POS) is updated automatically, and from v. 3.0 of the microprocessor card its firmware is then also automatically updated.

The LTMS version is operated in the same way as the ATMS except from the automatics. However, the LTMS allows automatic deposition, stirring and scanning.
Some modifications of the design from fall 2019.
The electrical connections are on the right side of the unit. The measuring cell is now in glass, with an adjustable stand:

![Image of modified design]

## 2 METHOD

### 2.1 General aspects and background

In chemical analyses concentrations of different species are measured. The units for the results are reported in per cent (%), per thousand (‰), g/L, mg/L (ppm), µg/L (ppb), or mole/L (M).

A prerequisite for a measurement is that the system is homogeneous; otherwise a system is not defined. This means that it has to be a solution (or a solid or a gas), and not a solution with a precipitate (unless the constituents from the precipitate can be ignored.

Speciation, being the actual form of a chemical compound is very important as this highly reflects the toxicity and other properties.

Special precautions have to be followed for handling measurements at trace levels (like many heavy metals/trace metals). A typical concentration of 50 ppb corresponds to only 1.5 µg in a measuring cell, consequently with risks of relative contamination. Pure chemicals are therefore required, in particular when it is used in high concentrations (like in supporting electrolytes). Clean water is also needed for the preparations, and even purified water should be tested. We have also experienced that deionized water can contain contaminants, like invisible particles from the ion exchanger, and this can destroy the results by removing the metals to be measured.

It is also important to have in mind that if the system has been exposed to highly concentrated solutions (say some ppm) and later on should be used for low concentrations (say some ppb), it can easily be a contamination from the previous application.
Furthermore it is important to have in mind the great difference between laboratory samples made from pure solutions, and real samples from lakes, rivers etc. Possible matrix effects should therefore be controlled.

There are numerous techniques to detect heavy metals. The most used methods are Atomic Absorption Spectroscopy (AAS), Inductively Coupled Plasma Spectroscopy (ICP), Inductively Coupled Plasma Mass Spectrometry (ICP-MS), chromatographic methods, and several different electrochemical techniques. Voltammetry is an electrochemical analytical technique where information about the analyte is achieved from measurements of electrical current in a sample, as a function of an applied potential in aqueous solutions. This current is a consequence from redox reactions occurring on an electrode surface.

It has many advantages compared to other techniques; it is a fast and easy analytical technique to carry out, the instrument is inexpensive compared to ICP, ICP-MS and chromatographic methods, and the operating costs are low. Voltammetric methods have a good sensitivity. The detection limit for many important heavy metals is in the low parts per billion (µg/L) range and even lower. Hence voltammetric methods covers concentration ranges down to drinking water requirements.

Finally, voltammetric methods can be used for online monitoring in the field and alternative methods suitable for this purpose are very limited.

Voltammetry has several advantages compared to other techniques. It is a fast and easy analytical technique to carry out, and renders the possibility for constructing online measuring systems. Additionally, voltammetric methods have a good sensitivity for many important heavy metals.

Because voltammetry involves redox processes, it is a prerequisite that such processes are involved. Metal ions like mercury, copper, cadmium, lead, thallium, zinc and many other metals of environmental interest can be measured. However, several other compounds like pesticides and others can also be monitored.

### 2.2 Electrochemical analysis

#### 2.2.1 Principles of Voltammetry

Electrochemical techniques are concerned with the interplay between electricity and chemistry, namely the measurements of electrical quantities, such as current, potential, or charge, and their relationship to chemical parameters. Voltammetric technique differs from other electrochemical methods since voltammetry is based on measuring the current developed in an electrochemical cell under complete concentration-polarisation. An advantage of voltammetry is that only a small fraction of the analyte is consumed compared to coulometry where the whole analyte is used and transferred to another form.

The theory of voltammetry is based on the redox properties of an element; e.g. lead (II) ions are reduced to solid lead, or solid lead is oxidized to lead (II) ions on the surface of a solid electrode:

\[
Zn^{2+} + 2 e^- \rightarrow Zn \text{ (s)} \quad \text{or} \quad Zn \text{ (s)} \rightarrow Zn^{2+} + 2 e^-
\]

The involved electrons make it possible to measure a current when the redox reaction is carried out. Several voltammetric techniques are available, and for detection of heavy metals the “stripping voltammetry” technique is among the most used. In this technique the analyte (metal ions) are first reduced
to a deposit on the surface of a working electrode. The different metals to be analyzed are then stripped off again by scanning the potential towards more positive values.

### 2.2.2 The voltammetric cell system

By using a potentiostat it is possible to control the voltage over a sensor electrode. When a redox-reaction is occurring, electrons are generated, and a measurable current proportional to the concentration of a given species is achieved.

Usually a voltammetric cell consists of three electrodes as shown in the figure below; the working electrode (WE), at which the analyte is measured, an auxiliary (counter) electrode (CE), and a reference electrode (RE). A current may flow between the working electrode and the counter electrode, and the potential of the working electrode is measured against the reference electrode. With the reference electrode hold at a known constant any change in potential difference, $E$, is applied to the working electrode. To reach that goal, the current passing through reference electrode should be very low. This is possible since the counter electrode enable the flow of current in the whole circuit. By varying $E$ and measuring $i$ the voltammetric curve are obtained.

![Principle drawing of a voltammetric system.](image)

Current is measured between the working electrode (sensor electrode) and the counter electrode. The potential is measured between the working electrode (sensor electrode) and the reference electrode. The potential (voltage) over the working electrode may be controlled and altered by regulate the resistance ($R$) in the upper circuit – electrolysis circuit. The lower circuit including the working electrode and the reference electrode is called the reference circuit.

#### 2.2.2.1 Working Electrode (WE)

The working electrode is the electrode at which the reaction of interest occurs. Generally, the working electrode in voltammetry is characterised by their small surface area, which enhances polarization. Different types of working electrodes are selected for different potential ranges, a roughly guide for some typical working windows for some common working electrodes in natural water added ammonium buffer (pH 5) as supporting electrolyte are;
Solid Silver Amalgam Electrode; - 1600 mV to -100 mV
Silver-Bismuth Alloy Electrode (10 %); - 1300 mV to -100 mV
Gold-Bismuth Alloy Electrode (10 %); -1000 mV to +900 mV

2.2.2.2 Reference Electrode (RE)
The reference electrode provides a known and stable potential that is sensitive to the composition of the solution under study and which the potential of the working electrode is compared. Often a Silver-silver chloride and saturated calomel electrode, connected to the sample with a salt bridge is used. The constant composition of the reference electrode remains unpolarized during the analyses.

2.2.2.3 Auxiliary (counter) Electrode (CE)
To minimize the errors from the cell resistance, a third electrode is added to the electrochemical cell. This electrode is made of a chemical inert conducting material with a reasonable surface area, often a Platinum wire. It minimizes the errors by controlling the potential of the working electrode.

2.2.2.4 Supporting electrolyte and gas purging
Theoretical treatment for deriving the equations for the peak current, demands minimization of electrical migration of the metal ion caused by the electrical field. This is done by adding an inert supporting electrolyte to the sample, which lowers, virtually to zero, the transference number of the ions measured. At the same time, this insures the conductive medium that voltammetry requires. The concentration of the supporting electrolyte is usually about 1M, and may be an inorganic salt, a mineral acid, or base. Samples with high salt content, e.g. sea water, do not normally require any addition of supporting electrolyte. The supporting electrolyte can be added by using a dosage pump, being controlled by the ATMS.
To prevent these unwanted oxidations in the sample the oxygen can be removed by purging the solution with an electronegative gas (nitrogen, argon, etc.), being controlled by the ATMS, but often this is not required.

2.3 Pulse Voltammetry and Square Wave Voltammetry

2.3.1 Differential Pulse Voltammetry
Pulse voltammetric techniques are aimed at lowering the detection limits of voltammetric measurements. By substantially increasing the ratio between the faradaic and no faradaic currents, such techniques permit convenient quantisation down to 10⁻⁸M concentration level or lower. One of the most widely used voltammetric techniques is differential pulse voltammetry, which is designed to compensate background noise like e.g. charging current. This is done by adding a modulated voltage pulse to a staircase ramp as illustrated in the figure below. The modulation pulse have an amplitude of typically 25 to 100 mV, a duration of about 50 ms, and a repetition rate of 0.5-5 s. Usually, the speed of the staircase ramp is slow, typically 2-10 mV/s. The current are sampled twice: prior to the pulse application and just before the pulse termination (see the figure below). Than the first current value is subtracted from the second one, and the current difference plotted versus the potential. The two current values which are subtracted from each other are actually two average values calculated from several individual readings over some few milliseconds (16.67 or 20 ms depending on a 60 or 50 Hz power supply). The resulting pulse voltammogram, illustrated in the figure below, consists of current peaks, the height of which is directly proportional to the concentration of the corresponding analyte:

\[
i_p = \frac{nFAD^{1/2}C}{\sqrt{Ft_m}} \left(1 - \frac{\sigma}{1 + \sigma}\right)
\]
\[ i_p = \frac{nFAD^{1/2}C}{\sqrt{\pi \tau}} \left( \frac{1-\sigma}{1+\sigma} \right) \]

where

\[ \sigma = \exp \left[ \frac{nF}{RT} \left( \frac{\Delta E}{2} \right) \right] \]

and \( n \) is number of electrons stoichiometric transferred in the redox reaction, \( F \) is the Faraday constant, \( A \) is surface area of the electrode, \( D \) is diffusion coefficient, \( C \) is concentration, \( \tau \) is duration of the pulse and \( \Delta E \) is the pulse amplitude. The maximum value of the quotient - obtained for large pulse amplitudes, is unity.

When the modulation pulse is applied, the total current in the system increases because of the resultant increase in faradaic and changing currents. The induced charging current decays more rapidly than the faradaic current. Because the charging current at the sampling points (prior to the pulse and at its end) is essentially the same, the difference between the readings is attributed mainly to the faradaic reaction (metal oxidation).

**Excitation signal and resulting voltammogram for differential-pulse voltammetry.**

It should be noted that the method corrects only for the non-faradaic charging current but is not effective against various faradaic current components of the background current. The differential pulse stripping peak currents are more susceptible to interferences by surface-active materials than the corresponding linear peaks because of the sensitivity of differential pulse measurements to small changes in rate of the electrode reaction.

### 2.3.2 Square Wave Voltammetry

In square wave voltammetry, a square wave is superimposed on the potential staircase sweep. The current is measured at the end of each half-wave, just prior to potential change. The differential current is then plotted as a function of potential, and the reduction or oxidation of species is measured as a peak or trough.
2.4 Stripping Voltammetry

2.4.1 Differential Pulse Anodic Stripping Voltammetry (DPASV) and Square Wave Anodic Stripping Voltammetry (SWASV)

In stripping voltammetry techniques, metals are first deposited on the electrode, subsequently to be measured by means of the potential scan from the oxidation or reduction current. The measured current is proportional to the concentration of the metal in the sample.

In the differential pulse anodic stripping voltammetry techniques, a pre-concentration step is introduced. This involves reduction of dissolved metal ions to solid deposits on the surface of the electrode by applying a large negative potential (normally 300 mV more negative than the easiest oxidized compound). The metal then remains on the electrode until they are stripped off as a function of a potential scan in the positive direction. This method is used to determine the “labile metal” concentration. “Labile metal” concentration will typically include the “free” metal ions, and weak inorganic / organic compounds of the metal.

The metal ions reach the surface of the electrode by diffusion and convection, and get reduced and deposit on electrode surface.

The convective transport is achieved by electron rotation or stirring of the solution or by stirring of the solution. The duration of the deposition step is selected according to the concentration level of the metal ions in question, from less than 0.5 min at the $10^{-7}$ M level to about 10 min at the $10^{-10}$ M level.

2.4.1.1 Deposition Step

The total amount of deposited metal plated represents a small but reproducible fraction of the metal present in the main sample.

The deposition potential is usually 0.3-0.5 V more negative than $E^0$ for the least easily reduced metal ion to be determined. The overpotential also taken into account the $iR$ drop, which is the small potential drop caused by the cell resistance ($R$). Because of the hydrogen evolution background reaction occurs at negative potentials, care must therefore be taken not to apply a deposition potential more negative than the give potential window for a specific electrode.
The deposition time must be controlled carefully, and the longer the deposition step the larger the amount of analyte available at the electrode during the stripping (measurement) step. Recommended deposition periods are no longer than those required to obtain well-defined stripping peaks.

2.4.1.2 Stripping Step

After the pre-deposition is ended, the forced convection is also stopped, and the potential is scanned anodically, either linearly or in a more sensitive potential-time (pulse) waveform Differential Pulse Anodic Stripping Voltammetry (DPASV) or Square Wave Anodic Stripping Voltammetry (SWASV) that discriminate against the charging background current. During this anodic scan, the metals are reoxidized from the electrode surface, and a current will flow:

\[ \text{Metal} \rightarrow M^{n+} + n \text{e}^- \]

The stripping current is proportional to the concentration of the analyte. Peak potentials serve to identify the metals in the sample.

The most important background component is the charging current. At the electrode-solution interface a separation of charge takes place that makes the electrode look like a capacitor. At a given potential a charge exists on the electrode and an equal opposite charge in the solution. The array of charged species and oriented dipoles existing at the interface is called the electrical double layer. When the potential of the working electrode is changed, a current must flow to charge or discharge the capacitor. This charging current is no faradaic, because it flows in the absence of an accompanying redox reaction.

Comparison between Differential Pulse Anodic Stripping Voltammetry (DPASV) and Square Wave Anodic Stripping Voltammetry (SWASV):

- In most cases SWASV is more sensitive than DPASV. However, this requires that the redox process is fast as it is for most reactions involving metals. But for a slow reaction, DPASV can be the most sensitive technique.
- The scanning time for SWASV is a faster than DPASV. A voltammogram can be obtained in a matter of seconds (if no preconcentration step is used) and can therefore be used for chromatographic detection.
- Both are pulse techniques and subtractive techniques.
- SWASV also provides kinetic information. Because of the ability to analyze both the forward and reverse currents as well as the net current, information about reaction reversibility and electrode structure can be obtained easily.

2.5 Some literature references about voltammetry

General information about voltammetry can be found in these references:


14
3. SYSTEM OVERVIEW

3.1 Description of the ATMS system.

The ATMS 600 system consists of the following essential parts (in one cabinet):
- The cell system with the electrodes (sensor)
- The microprocessor card (inside the cabinet in a metal enclosure)
- Pumps, magnetic stirrer etc.
- A PC for input, output and graphical presentation. This PC is only needed for this purpose, not for the running and this can be a laptop to be taken home after the visit to the station. This PC can be connected to the ATMS at the measuring station, or operated on another location via Internet.
- The system needs 12 V DC. If electricity is available, the use of an adapter is recommended.

In brief the system works as follows;

Sample is automatically pumped into the measuring system, if needed through a filter system
Sample is added “supporting electrolyte” non-toxic salts to improve the measurement
Sample is analyzed by use of new environmental friendly and patented sensor system (based on traditionally and well established electrochemical technique, voltammetry, but improved by new technology)
After measurement; computed results are automatically sent over internet or local area network for immediately surveillance
Sample cell are automatically emptied and a new sample routine is carried out

The voltammetric sensor system consists of three electrodes implemented in two connected circuits.
- The electrolysis circuit which consist of the counter electrode and the working electrode is used for controlling the potential over the working electrode. By applying a more negative or more positive voltage the environment over the working electrode surface will be respectively more reducing or oxidizing, and the resulting current flowing from any redox reaction can be recorded. Excitation signal voltage range is maximum ± 5 V, but normal range used is between – 0.5 and 2 V. The second circuit, the reference circuit, is used to measure the potential of the working electrode. This circuit consists of a high impedance circuit connection between the working electrode and the reference electrode, to ensure that no current flows through the reference electrode to through this stabilize the voltage on the reference electrode and make it independent of the cell impedance.
An electrometer operational amplifier with very low input bias current is used in the current to voltage converter. The working electrode acts as a virtual ground for the reference and counter electrodes.

It is recommended to disconnect the cell after the scan in order to protect the sensitive electrometer amplifiers.

3.2 Technical Specifications

Software
POS V1.5 (or above) running
Windows 2000™/ Windows XP and from ATMS600.v3 also Windows Vista and Windows 2000 and above (32 and 64 bit)
Date storage: On Computer or as stand-alone on a Compact Flash Card (CF).

Mechanical
Dimensions: 40 X 30 X 17 cm
ATMS 600D 60 x 30 x 17 cm
Weight: 8 kg
ATMS 600D 12 kg
Power Supply needed: 12 V DC (or adapter to mains)
Two power supplies can be used, one for the electronics and one for the pumps, stirrer etc., but it is normally sufficient to use one power supply only and connect both circuits to that one.

Electrode Connection: 3 X gold plated brass plugs

Polarization
Voltage range: ± 5V
Sweep Types: Differential Pulse/Square Wave/ Staircase
Sweep Direction: Anodic/Cathodic
Min. Sweep Step Height: 5/8 mV
Min Sweep Step duration: 10 ms

Measurements
Input impedance: > 10⁸ Ω
Current ranges: ±2 µA, 20 µA, 200 µA
Resolution Current measurement: 16-bit
Resolution Feedback: 16-bit

Communication
Serial: Communication over Modbus in RTU mode
LAN: Data delivery through web services or TCP direct

Assembling
See chapter 9.
4 INSTALLATIONS

4.1 Location and field installation

The ATMS 600 is ready to be used with electrodes and software. Some plugs from the cables are not supplied as those will be user-dependant. It can be placed on a table or on the wall (use the four holes on the four corners of the unit). It communicates with a PC, preferentially via USB or via network (XPort).

Before USB use, an UART to USB driver has to be installed on the computer, See: http://www.silabs.com/products/mcu/pages/usbtouartbridgevcpdrivers.aspx

The driver should be installed before the first time the ATMS is connected to the PC with the USB.

For Xport settings see chapter 5.4 – communication setup.

The first step is to perform an installation “at home” (in the lab, in the office etc.). Never do an installation in the field before you are familiar with an “at home” – installation.

The next step is then to run samples of the water being collected from the actual site. Then a field installation can take place. Field monitoring is much more challenging than laboratory measurements of pure solutions and matrix effects can also appear. As the site conditions can be very different from one place to another, special adaptations have to be considered: Is the supplied pump sufficient strong considering the height or the length from the water? Is special care needed to prevent frost? Is it needed to use a filter at the intake?

The installation is done according to this manual. The unit shall normally be placed close to the sample to be measured (preferable within 10 meters to avoid old samples to remain in the system), however the housing must be keep away from any fluids. If the equipment is to be installed in a corrosive environment, or any environment significant different from normal air, it is recommended to place the equipment in a sealed container left under nitrogen atmosphere.

Normally, gas purging of the cell is not required. However, a purging device (not included) can be connected being regulated by the ATMS. The corresponding cable gives 12 V DC when it is on and no connection when it is off.

Normally it is needed to add a supporting electrolyte, by using a dosage pump or a peristaltic pump (not included). Several brands of a dosage pump can be used. We have experience with the pump “Prominent Concept CNPA1000PPE200AB1” (or the corresponding 12 V DC bt4a1000PPE200MAD010000 if the mains electricity is not available). This pump is controlled by pulses by using the dosage pump cable connection. If other brands are used, the specifications should be controlled. Another alternative is also to use a peristaltic pump for the addition of the supporting electrolyte. This can be done in two ways:

- Addition similar to what is done with a dosage pump as the added volume of the electrolyte depends upon the pumping time. For such use, we recommend to use the gas purging controller to control the peristaltic pump (as the gas purging is normally not used) or
- To connect the power for this pump to the power for the water intake pump and the tube to the water intake inside the ATMS.
We recommend the addition of a rather concentrated supporting electrolyte, with a proper volume added accordingly, this being regulated by the ATMS when a dosage pump is used. The corresponding two cables are short-circuited when the pump is on, and with no connection when it is off.

If a peristaltic pump is used, the concentration of the supporting electrolyte in the measuring cell, \( C_{\text{cell}} = C_0 \frac{v_0}{(v_0 + v)} \) with \( C_0 \), \( v_0 \) and \( v \) as the concentration of the supporting electrolyte in the reservoir, the flow rate of the supporting electrolyte and the flow rate of the pure (diluting) water, respectively. Because of the high value of \( v \) compared with \( v_0 \) (about 100), \( C_{\text{cell}} \approx C_0 \frac{v_0}{v} \)

Some typical pump data are given in Appendix C.

**WARNING.** The ATMS runs by using 12 V DC and no higher voltage should be connected to it. That means that if the dosage pump or the purging device or other units use higher voltage (e.g. mains), a separate galvanic shielding (like a relay), will be required.

If an additional pump has to be used, be careful not to use a pump where the water is in contact with metallic parts, this due to possible contamination.

It is recommended to be careful when a filter is used because this can act as an ion exchanger making changes in the composition of the actual sample. However, a very coarse filter is recommended, just to avoid that stones, leaves etc. are entering the system. Such a filter is supplied as a standard.

If the concentrations of the expected metals are too high (above 200 ppb) saturation might appear in the measurements and the electrodes will be difficult to keep clean. This can partially be avoided by using a short deposition time; otherwise a dilution has to be done. If a peristaltic pump is used for addition of supporting electrolyte, such a dilution can easily be done by the following rearrangement:

- Use the tube to the external peristaltic pump (originally meant for the supporting electrolyte) as the intake pump for the water sample. If needed, the dimension of the tube inside this pump has to be adjusted.
- Use tube to the water intake pump (inside the ATMS) for intake from a bottle of pure water containing the proper amount of supporting electrolyte.

The two peristaltic pumps inside the ATMS are used for filling and draining, respectively. The standard rotation for both are clockwise. The pumping time for filling is normally longer than for the draining and during the filling the water is usually pumped from a lower level and with longer tubes that for draining. Consequently, the need for maintenance will be more frequent for the filling - than for the draining pump. For that reason it is recommended from time to time (say twice a year) to switch the pumps between being used for filling and for draining, in order to increase the lifetime. This is done with a pump toggle switch outside - on the left side of the pump-box with and by interchanging the corresponding tubes. If wanted, but this is not our standard, a similar circuit can be installed to reverse the rotation of the pumps (by reversing the polarity). This can be useful for cleaning the tubes. However, this cannot be switched just whilst the pump is rotating because this will damage the pump.

**FIELD INSTALLATION**

Prior to a field installation it is needed to perform tests in the laboratory using pure water as well as water samples from the actual water system. Always consider possible interferances in polluted systems. If purification reagents are added, this will or course lower (or remove) the concentrations of the metals to be monitored.

**Frost precaution (if applicable)**

The temperature of the measuring system is not very important, but measures against freezing of the water have to be taken. The equipment has to be placed in a room or a contained being heated to avoid frost and the tubing to the water source has to be kept frost free using electrical tube heating, or by other means.
Pump capacity

The equipment is supplied with two standard peristaltic pumps, for filling and draining. This will normally manage a pumping height of about four meters with a tube length of about ten meters. Otherwise another type of pump has to be applied.

Water intake

If it is not needed, do not filter the water because the filter can affect the results. Use a coarse filter only, to avoid leaves or big particles to enter the system. Because this is for monitoring of metals at trace levels, avoid any contact with the water and metallic parts (in the pump, tubing etc.).

4.2 Electrodes and measuring cell

The ATMS system is delivered with a standard voltammetric cell and a standard set of electrodes (reference electrode, counter electrode, and working electrode). Different types of working electrodes are available and can be supplied additionally to the system delivery.

For testing of the electronics, an internal “dummy cell” can be used without electrodes. This is a connection between the reference electrode and the counter electrode with a resistor of 10 000 ohm, and with a resistor of 10 000 ohm between the counter electrode and the working electrode. This is found on Profile->Scan Profile under “Cell” with “Test Cell”. For testing in Linear Scan Mode this will make a straight line.

4.3 Electrical connections

The ATMS system should only be connected to 12 V DC. Several different power supplies can be used; one alternative is Farnell product number 133-7236. The power supply has to be galvanically isolated from the mains. It is possible to use two separate power supplies, one for the electronics on the card and one for the pumps and other connected devices. Normally it is not needed to use more than one power supply for both.

4.4 Software installation

All software is preinstalled on the supplied PC and is ready to use, and will be updated automatically from Internet on startup of the software. This also includes updating of any new firmware for the microprocessor card (board). For installation on another PC, the software can be downloaded from: www.sensaqua.com/download

NOTE: It is recommended not to connect/disconnect electrode connectors when the unit is powered on.

When measuring at low levels with the highest amplification, interference from mains network and electrical equipment may result in noise on the scan data. Shielding the measuring cell properly may reduce this effect. Ideally, a complete metallic shield should surround the voltammetric cell system. The electrode connectors shall then be connected with the cable shield to the shield of the cell.
4.5 Connecting to Internet

This is done by using the network cable (RJ45). If Internet is not available, a mobile connection can be used but this requires RJ45 connection. However, as most of the equipment available for mobile connection are connected via USB, an USB modem with a router with RJ45 can be used.

5 POS SOFTWARE; OPERATING INSTRUCTIONS

5.1 What is POS?

POS (Process Online Software) is PC based software which automates the process of the ATMS system. The software has basically two parts; one part for control and measurement, and another to process measured data.

Each individual setup with the required parameters is stored on the computer and act as a template for the measurements. Different measurements can be run in a given sequence, which also can be repeated automatically.

5.2 System Requirements

IBM PC/AT or similar, running Windows 2000 and above (32 or 64 bit)
NET framework 1.1 or higher
Approximately 16 Mb of free space on installation drive

5.3 POS Software Setup

By double-clicking on the POS icon on your desktop, POS will start up.
POS’ main window, after start up

The software is now ready to start measurements. The program is stored in ...Start Menu\Programs\Sensaqua\POS

**Menus:**
The File menu:
Open: Opens previous scans, also being templates for new scans
Save As and Save: Scans are saved
Settings (see below): General Settings
                             Communication Settings
Language: English
                             Chinese (in preparation)
SA Sensor (see below)
Page Setup
Print
Export to XnC
View Multiple Scans: More saved scans are visible simultaneously

The Profile menu:
Scan Profile (see below): Data for running the measurements
Metals Definitions (see below): Data needed for calibration
The Scan menu: Starts a measurement
The Help menu: Help and program information

5.3.1 Checking the SensAqua Sensor (SA Sensor)

File -> SA Sensor -> Sensor Info

SA Sensor Info window

Sensor Time: Displays the time and date set in the sensor, can be changed with the button PC Time -> Sensor

The buttons Cell and relays in this window are for testing only and are not a part of the setup (this being done in the Scan profile window):

- **Cell**: Selects Cell 1 or Cell 2. Cell 2 is only applicable for ATMS 600D (the dual cell version).

Do not press “Update” if a card version older than v3 is used
- **Relays**: Here the different relays can be manipulated for testing. Select relay by clicking on/off and the relay for the selected cell should respond.

Additional rinsing by filling and draining can be performed by pressing the actual buttons.

**Standalone Settings**: The sensor can work alone without the aid of a PC. Set Delay between runs in minutes. Download a valid scan profile to sensor (select a premade scan file) and select standalone enabled.

**Data Output**: Selects where the measured data should be put.

**Sensor Communication port**: Selects standard sensor communication port. The same port has to be used as for the previous measurement, otherwise the sensor will not be found. When the sensor is found, another of the communication ports can be selected.

**Firmware Update**: If not greyed, new firmware is available, (requires Internet). See above.

### 5.3.2 Setting up Scan profile

**Profile->Scan profile**

The scan profile contains various parameters to control, and perform a scan. Before a scan can be run a scan profile has either to be setup, or loaded as a template from disk.
The Scan profile dialog

The dialog box shows a typical scan profile for differential pulse voltammetry. The scan profile has two main parts (“Scan” and “Control”), these and their parameters will explained in detail below. For linear scan voltammetry, (rarely used as an analytical technique) and square wave voltammetry, analogous dialog boxes will appear.

Scan menu

Dep. Pot: Deposition potential usually set to a potential which is 250-300 mV more negative than the first expected metal.

Start Pot: Define at which potential the voltammetric scan shall start. The start potential can be set in the range of ±5 V. NOTE; start potential must be selected in accordance to the potential window for the used working electrode (see section 2.2.2.1 above).
**Stop Pot:** Define where to stop the voltammetric scan. The end potential can be set in the range ± 5 V. The stop potential is automatically recalculated to the nearest inserted value after pressing OK in the ScanSetup dialog box, this to maintain the given scan rate. NOTE; start potential must be selected in accordance to the potential window for the used working electrode (see section 2.2.2.1 above).

**Rest Pot:** This parameter allows for the working electrode to be set at a given potential. This is true only if “Disconnect the electrode after scan” in the Control section is not enabled. NOTE; start potential must be selected in accordance to the potential window for the used working electrode (see section 2.2.2.1 above).

**Scan Rate:** Scan rates of 1, 2, 5, 10, 15, 25, 50, 75 mV/s can be selected. The stop potential of the scan will be recalculated to maintain the scan rate.

**Diff. Pulse:** This parameter sets the height of the modulation pulse in the differential pulse technique. The following values can be set: 5, 10, 15, 25, 50, 75, 100. The higher the diff pulse is the higher the sensitivity is, but at the same time the resolution decreases with higher diff pulse.

**Current range:** Three different current range settings can be selected to maintain the highest possible resolution/range. These are ± 2000 nA, ± 20 µA, ± 200 µA.

**Dep. Time:** Deposition time in seconds. Range from 0 - 65535.

**Equ Time:** An equilibration time can be added between deposition time and the scan. The deposition process will continue during the Equ time.

**Noise Filtering:** If selected a 5 point gliding window filter is used on the data after the scan is finished. This filter can be used to remove induced noise.

**Store Data:** If selected data will be stored if ATMS is running this scan automatically.

Square Wave:
- **Squ Amp:** Sets the square wave amplitude.
- **Squ Freq:** Sets the square wave freq.

**Control menu**

**Electrode:** Two different types of electrodes can be used:
- HMD Hanging Metal Drop (e.g. mercury drop)
- Solid electrode (e.g. solid silver amalgam electrode)

One can also choose to disconnect the working electrode after the scan.

**Cell:** Two different cells (for ATMS600D only) can be controlled by POS. Select either Cell 1 or Cell 2 for the current scan. For ATMS600 only Cell 1 is active.

With “Test Cell”, no cell is connected, but an electronic circuit is simulating a cell. This is for diagnostic purposes.

**Agitation** (with a magnetic stirrer): Three different modes can be selected:
- None, no agitation will be used
- Equ Time, agitation from the deposition time until the equ. time.
- Through Scan, agitation from the deposition time until the scan is finished.

**Fill Time:** Time used to fill a sample into the cell. Range from 0-65535 seconds. This time has to exceed the time to fill the cell to the overflow level.

**Electrolyte:** Used to control the amount of electrolyte used in the sample.

**Nitrogen Treatment** (normally not used): The time used to treat a sample with nitrogen. Range from 0-65535 seconds.

**Drain Time:** Time used to drain the cell. Range from 0-65535 seconds. This time has to exceed the time to drain the cell.

For additional rinsing in an automatic setup, an additional “scan” can be done with very short or time for other parameters than draining and filling.

### 5.3.3 Setting up Metal Definition Table

**Profile->Metal Definitions**

POS can find the concentrations of up to six metals. Select “Profile”->”Metal definitions”. The dialog box in the figure below will now appear.

![Metal Definitions Table dialog box](image)

**Metal Definitions Table dialog box**

To enable POS to search for a metal, the user has to give the following parameters:

- Metal name
- Lower search border. That means the lowest voltage we have for the actual peak
- Higher search border. That means the highest voltage we have for the actual peak
- Two currents with corresponding concentration.
All values to be inserted in the Metal Definition Table has to be computed from a manual two point calibration for each individual metal as explained in section 5.3.4.

### 5.3.4 Calibration (see also chapter 7.1)

By calibration, also called standardization, we convert the measured values (peak currents) to concentrations. This is done by comparing with standard solutions, assuming linearity.

POS needs two calibration points in order to determine the concentrations of the different metals in the sample. These two points can be found by scanning a sample once, and scanning the sample once more after addition of a small volume of a concentrated solution with known quantities of the actual metals to be measured (method of standard addition). By using an original solution we keep as close as possible to the natural matrix of the samples. The software uses then a two point straight line to convert current to concentration, assuming linearity in the actual measuring range.

As a very general guideline for metals like zinc, cadmium, lead and copper, the linearity range is approximately 500 ppb, 200 ppb, 100 ppb and 50 ppb for deposition times of 60 s, 120 s, 300 s and 600 s, respectively.

Use the following sequence and procedure for obtaining the values to be used in the “Metal definitions”:

1. Run a scan with the sample only, without any addition of standard solution.
2. Add a known volume of a standard solution with known concentration of one or more metals and run a new scan. Adapt the added volume and/or concentration of the standard to obtain a significant increase (more than 30 %) of the original peak.

Legend:
- \( h_1 \) and \( h_2 \): Peak heights (of each metal) before and after the addition of standard solution
- \( C_1 \) and \( C_2 \): Concentrations (of each metal) before and after the addition of standard solution
- \( C_x \): The concentration (of each metal) of standard addition solution
- \( V_x \): The added volume of the standard solution
- \( V_0 \): Volume of the sample before the addition of the standard

For each actual metal, measure the peak height (measured from the background value) for the metal in question for the two separate scans (\( h_1 \) and \( h_2 \)).

Then we use the equations for \( C_1 \) and \( C_2 \) below to compute the concentration of each metal before and after the addition. The \( \approx \) value is used when volume change can be neglected (which normally can be done if the standard is concentrated):

\[
C_1 = \frac{C_s \times V_s}{\frac{h_2}{h_1} (V_0 + V_s) - V_0} \approx \frac{C_s \times V_s}{V_0} \times \frac{h_1}{h_2 - h_1}
\]

\[
C_2 = \frac{C_s \times V_s}{\frac{h_1}{h_2} (V_0 + V_s) - V_0} \approx \frac{C_s \times V_s}{V_0} \times \frac{h_2}{h_2 - h_1}
\]

in the “Metal Definition Table”, insert the obtained values (peak height current (\( h_1 \) = “Current 1”) and the corresponding concentration (\( C_1 \) = “Conc 1”) and (peak height current (\( h_2 \) = “Current 2”) and the corresponding concentration (\( C_2 \) = “Conc 2”). As a visible control, see if the ratio of the peaks corresponds to the ratio of the concentrations.

For measuring, right click inside the POS window and select “Pick point” and “Enable”-
Then from a measured current \( h \) the corresponding concentration is given by

\[
C_h = \frac{C_i \times V_i}{h_2(V_0 + V_x) - h_1 V_0} \times h = \frac{C_i \times V_i}{V_0(h_2 - h_1)} \times h
\]

and POS calculates this automatically. An example is given in chapter 7.

If the initial solution is water without the actual metal, \( h_1 = 0 \) and \( C_1 = 0 \) and only one experimental calibration point is required. For calculation also see the appendix.

### 5.3.5 Starting a Scan

Before starting a scan, a new scan profile should be set up, or a stored scan file should be loaded. To load a scan file use File -> Open or move the actual file into the POS window. Do not load the actual file by double clicking on it from a directory.

To start the scan simply press “Scan->Start”.

### 5.3.6 Analyzing a Scan

After a scan has been run, it can be analyzed in the following ways;

**Visual inspection:** One can visually inspect the voltammogram, and determine which types of heavy metals are in the sample. The concentration will be represented by the height of the peak.

**Automatic calculation:** If metal definitions are set, POS will automatically calculate the concentrations of up to six preselected metals, and show the values in the upper left corner in the software. Based on the input values given in the metal definition dialog box, the values has to be found by manual calibration, the software will automatically estimates the metal concentrations. Detected concentration for selected metals will be logged and stored in a text file together with time and date for the when the analysis was carried out. The text file with the same name as the voltammogram can be launched in notepad. Further analyzes can be done by opening the log file in a spreadsheet like Microsoft Excel.

The function searches for a peak within a predefined section of the voltammogram. The maximum current value within this section is used in a first-order approximation of the metal concentration. Baseline is estimated by drawing a line between the current values at the low- and high limit of the section. The concentration is then found as the distance from the baseline to the extrapolated highest point multiplied by a calibration constant.

The raw data and scan log are stored like this:

- The scan files:
  - Path to store automatically generated files: \( \text{\textbackslash scan file name\textbackslash Scans\scanfiles.sxl} \)
  - The scan log (calculated results):
    - Path to store automatically generated files: \( \text{\textbackslash scan file name\textbackslash scan.log} \)

  The: Path to store automatically generated files\textbackslash scan file name is set on “File->Settings->General Settings”. The default names of scanfiles.sxl are date-time.sxl (like 21.02.10-10.20.06.sxl).

### 5.3.7 Automatic measurement (see also chapter 7.2)
POS can do automatic measurements. This can be done it several ways:

- Timed measurements
- As a Modbus slave
- As a TCP Server
- Or as a combination of those three.

**Timed measurement**
In File->Settings->General Settings, POS can be setup to start a measurement using a timer.

**General settings dialog, setup for timed measurement, and select sensor type**

The figure shows an example setup for timed measurements. The following parameters have to be given to run timed measurements:

- A path to store automatic generated files. This is generated in separate directories for each of the template scan files given below, also with a file with the calculated results (Scan.log). The name(s) of each directory will be given the name of the file(s) in the template (without extension)

Example from the settings above:
The scan files to run automatically are
C:\Users\Knut Schroder\Desktop\sxl\Run1.sxl and
C:\Users\Knut Schroder\Desktop\sxl\Run2.sxl
The path is
C:\Users\Knut Schroder\Desktop\sxl\
This means that the results will be stored in the path with the subdirectories Run1 and Run2, respectively:

C:\Users\Knut Schroder\Desktop\sxl\Run1\ and 
C:\Users\Knut Schroder\Desktop\sxl\Run2\ 
with the subdirectory “Scans” with all the individual scans (as .sxl files) and file “Scan.log” in Run1, like 
C:\Users\Knut Schroder\Desktop\sxl\Run1\Scan.log and 
C:\Users\Knut Schroder\Desktop\sxl\Run1\Scans\....sxl (all the scan files)  
and similar for Run2 (and other possible runs):  
C:\Users\Knut Schroder\Desktop\sxl\Run2\Scan.log and 
C:\Users\Knut Schroder\Desktop\sxl\Run2\Scans\....sxl (all the scan files)

- One or more Template scan files, which POS will run each time.  
- When all the Template scan files are run, a new sequence of measurement will be started from the top of the list, after a delay of the cycle time  
- Check the “Automatic Scanning enabled” box.

In the example above, with Automatic Scanning enabled, a scan with the parameters given in Run1.sxl is performed, followed by a scan with the parameters given in Run1.sxl, after 30 min this is repeated.
The scans are stored in the desktop folder sxl.

Several parameters cannot be changed before Automatic Scanning is disabled. 
Sensor type is always SensAqua (not EagleDAQ). Accepted Communication ports are assigned automatically.

The template file contains all settings for running a measurement, except the settings in: File->Settings->General Settings and File->Settings->Communication Settings

5.3.8 Automatic measurement sequence

The actual time/action flow for the automatic scanning sequence is illustrated in the Gantt chart given in the figure below. The length of the progress bars is fictitious. The automatic sequence is divided into the following steps;

cell drainage; remove previous sample in the system 
cell fill; sampling of fresh sample 
electrolyte; addition of supporting electrolyte 
nitrogen treatment; this step is only carried out if a nitrogen purging system has been installed 
agitation; the agitation device is started (see different options for agitation above) 
dep time; the voltammetric predeposition step is started 
equ time; the agitation device is stopped (the voltage is kept at the Deposition Potential) 
scan; the voltammetric scan and measurement is started

For additional rinsing in an automatic setup, an additional “scan” can be run, with very short time set for other parameters than draining and filling.
5.4 Communication Setup

File->Settings->Communication Settings

The ATMS needs a PC for setup, storage of data and data presentation. More ATMS-stations can also be run using one PC with TCP communication. The PC has then to be set up as more virtual machines working independently, see: [http://www.vmware.com/products/workstation/features.html](http://www.vmware.com/products/workstation/features.html)

POS in the ATMS has four ways of communicate with other devices (in addition to RS232, rarely used):
- USB connection (if the ATMS is located close to the PC)
- TCP communication as a TCP Server
- Modbus communication, as an RTU slave
- Data transmission through web services

Plus a “standalone” where it is only a connection at starting up for the settings, with data storage on a CF-card.

*The default communication is USB. Please notice that if this is set to TCP, a TCP connection will be required in order to switch to USB next time.*

*The use of the TCP connection requires a stable Internet line. An alternative is to use the USB connection with a PC close to the ATMS with remote connection with TeamViewer.*

For USB connection:
The proper driver has to be installed see chapter 4.1

For TCP communication as a TCP Server:
The sensor card have the possibility to communicate with an external computer connected through the integrated onboard TCP server solution from Lantronix. Please follow the procedure described in the Lantronix Quick Start manual; [http://www.lantronix.com/pdf/Com-Port-Redirector_QS.pdf](http://www.lantronix.com/pdf/Com-Port-Redirector_QS.pdf)
Needed software (Lantroix Com Port Redirector) may be downloaded from the Lantronix Software Download link; http://ltxfaq.custhelp.com/app/answers/detail/a_id/928

Please note that to be able to detect or communicate with any devices on the network the "Internet Connection Firewall" must be disabled, and that UDP Ports 30718, 43282, 43283 must be available. Please refer to your local internet provider if other or more special configurations are needed.

After starting up the mentioned Lantroix Com Port Redirector, a port has to be added (any available port can be used):

Use the parameters given above and fill in the IP address (marked in red) or Search for (local) Devices. Remember to save before proceeding.

Then put the below settings in the MS Windows system settings (in Device Manager/Ports & LPT) for the Lantronics com port:
Then, in POS, select (if this is not selected automatically) the correct Communication Port (under General settings) as the added Lantroix port:

**Modbus communication, as an RTU slave:**

![Modbus communication setup](image)
Communication setup dialog in POS
The POS software implements basically two main functions. These functions will enable
POS to communicate with a SCADA system as a Modbus slave.
POS supports Modbus serial communication in RTU mode.
The format for each byte (11 bits) in RTU mode:
Coding: 8-bit binary
Bit definition:
1 start bit
8 data bits
1 bit parity
1 stop bit
POS supports odd, even and no parity. However when no parity is used it is required to
use 2 stop bit
The following baud rates are supported:
- 4800
- 9600
- 19200
To use Modbus controlled measurement, the following parameters has to be set:
• A path to store automatic generated files (General Settings)
• A template scan file, which POS will run each time. (General Settings)
• Check the "Modbus Communication Enable" box (Communication Settings)
Also the desired Modbus address and communication settings must be set. (Communication Settings)

04 (0x04) Read input registers
This function is used to read 1-11 registers in POS. The registers contain data concerning measured
metals.

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Analyzer status</td>
</tr>
<tr>
<td>1</td>
<td>Year (of last measurement)</td>
</tr>
<tr>
<td>2</td>
<td>Month (of last measurement)</td>
</tr>
<tr>
<td>3</td>
<td>Day of month (of last measurement)</td>
</tr>
<tr>
<td>4</td>
<td>Hour (of last measurement)</td>
</tr>
<tr>
<td>5</td>
<td>Minute (of last measurement)</td>
</tr>
<tr>
<td>6</td>
<td>Second (of last measurement)</td>
</tr>
<tr>
<td>7</td>
<td>Metal 1 concentration (concentration x 100)</td>
</tr>
<tr>
<td>8</td>
<td>Metal 2 concentration (concentration x 100)</td>
</tr>
<tr>
<td>9</td>
<td>Metal 3 concentration (concentration x 100)</td>
</tr>
<tr>
<td>10</td>
<td>Metal 4 concentration (concentration x 100)</td>
</tr>
</tbody>
</table>

All registers contains a 16 bit integer.

05 (0x05) Write single coil
This function code is used to set an output ON or OFF. The only supported output address for POS is
1296 (0x0510). This output is used to either start or stop¹ a measurement.

¹Stop of a measurement is not yet implemented.
Data transmission through web services
POS can transfer measured data to server via a special web service. The web-service has to be installed on an own server (contact us for details).

Transmitting data through web service can be enabled in the Communication Settings dialog. The following parameters have to be set:
Station ID, the name/number of the station
Transfer Scan, if set it will transfer the whole voltammogram as well as the concentrations
Web-service URL, server address, including the service itself.

The server allows for starting measurement, and read measured data. The server should only be used on LAN’s as it does not require user authentication.

To use TCP controlled measurement, the following parameters has to be set:
A path to store automatic generated files (General Settings)
Template scan file(s), which POS will run each time. (General Settings)
Check the “TCP Server Enable” box (Communication Settings)
Listen IP (Communication Settings), the IP address of the Ethernet adapter
Port (Communication Settings), the communication port to listen to

The following commands are supported:
“start”
The start command tells the server to start a measurement. The server will respond with one of the following strings:
OK, if a measurement could be started
Running, if a measurement is already running
ConfigError, if a template scan file could not be found

“get”
The commands ask the server for the latest measurement data. The server will respond with the following string:
Date Time;met1=xx;met2=xx;met3=xx
If multiple scans are in the sequence all metals defined will be put out in the response string from the get command (limited to 400 bytes).

6 SERVICE INSTRUCTIONS

Please have in mind that this is a method for monitoring of compounds at trace levels. Clean handling is therefore very important. Clean chemicals and clean water are needed for calibrations. Very high purity (analytical grade) of the supporting electrolyte is needed because the concentration is high. It is also needed to have in mind that measurements of high concentrations might contaminate consecutive measurements with low concentrations.
6.1 Start-up inspection

To make your first test of the equipment follow this procedure;

- Control that all cables are correctly connected before switching on the instrument, using the main power switch
- When the Microsoft Windows operating system has finished its initialization, double click the POS icon on the desktop to start the POS program which controls the measuring system
- In Scan profile dialog box insert values given in Test table below
- Fill the voltammetric cell with 30 mL distilled water and add 300 \( \mu \)L NH\(_4\)Cl (\( \text{pH} = 6.4 \)) electrolyte solution, or simply add 0.1 g NH\(_4\)Cl salt directly in the cell.
- Control that all electrodes are well connected with their appurtenant cables
- Start the voltammetric scan, and observe that all hardware is function properly by register that each device is switched on for 10 second and then switched off again.

### Test table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dep. Pot</td>
<td>- 500 mV</td>
</tr>
<tr>
<td>Start Pot</td>
<td>- 500 mV</td>
</tr>
<tr>
<td>Stop Pot</td>
<td>- 400 mV</td>
</tr>
<tr>
<td>Rest Pot</td>
<td>Disconnect the electrode after scan</td>
</tr>
<tr>
<td>Scan Rate</td>
<td>15 mV/s</td>
</tr>
<tr>
<td>Diff. Pulse</td>
<td>10 mV</td>
</tr>
<tr>
<td>Current range</td>
<td>200 ( \mu )A</td>
</tr>
<tr>
<td>Dep. Time</td>
<td>20 s</td>
</tr>
<tr>
<td>Equ Time</td>
<td>15 s</td>
</tr>
<tr>
<td>Noise Filtering</td>
<td>On</td>
</tr>
<tr>
<td>Electrode</td>
<td>Solid</td>
</tr>
<tr>
<td>Agitation</td>
<td>Equ Time</td>
</tr>
<tr>
<td>Fill Time</td>
<td>10 s</td>
</tr>
<tr>
<td>Electrolyte</td>
<td>10 s</td>
</tr>
<tr>
<td>Nitrogen Treat.</td>
<td>10 s (accessory)</td>
</tr>
<tr>
<td>Drain Time</td>
<td>10 s</td>
</tr>
</tbody>
</table>

**Warning!** When performing the test procedure, the tubing from the sampling pump should also be installed in same matrix as used in the voltammetric cell. All external devices, sampling pump, dosage pump, magnetic stirrer etc. has separately manuals or operation guides, which all needs to be study carefully before operating the ATMS system.

6.2 Periodical maintenance

This section gives an overview of needed inspections and maintenance of the SensAqua ATMS system. The frequency of maintenance will strongly depend on the sample quality and configuration of the system. During the first weeks of operations the system operator should follow the ATMS system closely, and establish a maintenance procedure based on actual observations and experiences. The maintenance procedure will be specific and directly connected to the actual use of the ATMS system. Some of the most important modules in the ATMS system which should be inspected or periodically maintained are given in the Maintenance Table below.

### Maintenance Table

| Module               | Maintenance | Calibration |
|----------------------|-------------|-------------|-------------|

36
<table>
<thead>
<tr>
<th>Component</th>
<th>Task Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>Replace fuse in overvoltage protection when needed.</td>
<td>None</td>
</tr>
<tr>
<td>Peristaltic sampling pump, drain pump and supporting electrolyte pump</td>
<td>Replace silicon tubes when fouling or deposits are observed.</td>
<td>None</td>
</tr>
<tr>
<td>Dosage pump</td>
<td>Aeration of dosage pump system if needed. Study the operation manual carefully before any use or maintenance of the dosage pump</td>
<td>Adjust to a proper amount at system start-up.</td>
</tr>
<tr>
<td>Gas valve (accessory)</td>
<td>Replace gasket if any leakage of gas is observed.</td>
<td>None</td>
</tr>
<tr>
<td>Voltammetric cell / electrodes</td>
<td>Clean cell with citric acid* if fouling or deposits are observed. Refer to individual procedures for maintenance of electrodes.</td>
<td>Control sample volume ($\approx$ 30 mL) at system start-up.</td>
</tr>
<tr>
<td>Magnetic stirrer</td>
<td>Keep dry, avoid spill of sample solution. It should be covered with a plastic bag.</td>
<td>Adjust to a proper speed at system start-up.</td>
</tr>
<tr>
<td>ATMS analyser</td>
<td>None</td>
<td>Periodical</td>
</tr>
<tr>
<td>Steering circuits</td>
<td>Replace plug-in relays if malfunction.</td>
<td>None</td>
</tr>
</tbody>
</table>

* Other solutions may be needed for sample solutions different from drinking water

### 6.3 Procedure for maintaining the cell and electrode system

The voltammetric cell and electrodes require regular cleaning. Such cleaning could be carried out by washing the cell system and the electrodes in citric acid (0.01 M). Four to six hours after cleaning the system, the ATMS measuring system should be recalibrated by use of commercial able micro pipettes and standard solutions for each metal to be monitored. Warning: standard solutions of e.g. heavy metals and trace metals may be toxic, and specific care should be taken. Please refer to datasheet for handling these chemicals. Before cleaning or maintenance of the system follow this sequence;

Check that no scan is running.  
Stop the automatic measurements by removing the tick in the “Automatic Scanning enabled” box in the “Settings” dialog box.  
Switch off the system.  
Unscrew the electrodes, and carefully clean them with some weak citric acid  
Fill the voltammetric cell with citric acid (0.01 M) and leave it for some minutes before pouring it out again. Wipe up with a clean soft cloth and rinse several times with distilled water.  
Inspect if any tubes needs to be replaced and do so if needed.  
Inspect level of supporting electrolyte, refill if needed.  
Inspect if there is any air bubbles trapped in the tubes from the pumps. Remove any air bubbles by following the operation manual for the separate pumps.  
Install the electrodes after individual maintenance (given below) and carefully connect the electrodes to their respective cables.  
Switch on the system, and open the POS software. In the “Settings” dialog box check the “Automatic Scanning enabled” box, and leave the system for four to six hours before re-calibrating the system.

#### Polishing the amalgam electrode (ATMS--DAM)
First polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P2500) in a figure-of-eight pattern for 30 seconds.

Than polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P4000) in similar figure-of-eight pattern, until a shiny mirror like surface is obtained.

Wash the electrode with distilled water, and install in the cell system.

*Never use coarser polishing devices than described in this manual.*

The polishing should be carried out manually or with a polishing machine. If manually polishing is carried out, use as much force as possible, forcing the electrode towards the polishing paper and polish in a figure-of-eight pattern. The electrode surface could advantageously be inspected in a microscope.

**Testing the amalgam electrode (ATMS-DAM)**

For differential pulse voltammetry use the following procedure;

Insert the electrode together with the two other electrodes (counter electrode of platinum and reference electrode of Ag/AgCl) in an ammonium chloride solution (0.05 M).

Use a scan with 120 seconds deposition time at -1350 mV, scan rate of 15 mV/s and a modulation pulse of 50 mV. End potential should be –100 mV.

After repeating this scan five to ten times, the background current should stabilize and a stable base line should be obtained (a relatively flat signal should be obtain in the range from –1200 mV to –300 mV).

After a steady base line has been achieved, add 25 ppb of zinc and lead, and repeat the scan, now two peaks the first appearing at −1050 mV (Zn) and the other one at −500 mV (Pb) should be observed.

Wash the cell and electrodes in distilled water, and fill the cell with ammonium chloride solution (0.05 M), repeat the scan. No peaks should be observed.

**Polishing the gold-bismuth electrode (ATMS-AuBi)**

First polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P2500) in a figure-of-eight pattern for 30 seconds.

Than polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P4000) in similar figure-of-eight pattern, until a shiny mirror like surface is obtained.

Further polish can be carried out using diamond past

Wash the electrode with distilled water, and install in the cell system.

**Testing the gold-bismuth electrode (ATMS-AuBi)**

For differential pulse voltammetry use the following procedure;

Insert the electrode together with the two other electrodes (counter electrode of platinum or glassy carbon, and reference electrode of Ag/AgCl) in a fresh nitric acid (0.01 M) solution added sodium chloride (0.01 M).

Use a scan with 120 seconds deposition time at +200 mV, scan rate of 15 mV/s and a modulation pulse of 50 mV. End potential should be +750 mV.

After repeating this scan five to ten times, the background current should stabilize and a stable base line should be obtained (a relatively flat signal should be obtain in the range from +200 mV to +700 mV).

After a steady base line has been achieved, add 5 ppb of mercury, and repeat the scan, now a peak at +550 mV (Hg) should be observed.

Wash the cell and electrodes in distilled water, and fill the cell with a fresh nitric acid (0.01 M) solution added sodium chloride (0.01 M), repeat the scan. No peaks should be observed.
Polishing the silver-bismuth electrode (ATMS-AgBi)

First polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P2500) in a figure-of-eight pattern for 30 seconds. 
Then polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P4000) in similar figure-of-eight pattern, until a shiny mirror like surface is obtained. 
Wash the electrode with distilled water, and install in the cell system. 
The polishing should be carried out manually or with a polishing machine. If manually polishing is carried out, use as much force as possible, forcing the electrode towards the polishing paper and polish in a figure-of-eight pattern. The electrode surface could advantageously be inspected in a microscope.

Testing the silver-bismuth electrode (ATMS-AgBi)

For differential pulse voltammetry use the following procedure; 
Insert the electrode together with the two other electrodes (counter electrode of platinum and reference electrode of Ag / AgCl) in an ammonium chloride solution (0.05 M). 
Use a scan with 120 seconds deposition time at -1000 mV, scan rate of 15 mV/s and a modulation pulse of 50 mV. End potential should be -50 mV. 
After repeating this scan five to ten times, the background current should stabilize and a stable base line should be obtained (a relatively flat signal with a plateau in the area --500 to -250 mV and a sharp increase in the current at -50 mV should be obtained. 
After a steady base line has been achieved, add 25 ppb of lead and copper, and repeat the scan, now two peaks the first appearing at -400 mV (Pb) and the other one at -150 mV (Cu) should be observed. 
Wash the cell and electrodes in distilled water, and fill the cell with ammonium chloride solution (0.05 M), repeat the scan. No peaks should be observed.

Polishing the glassy carbon electrode (ATMS-GC)

First polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P2500) in a figure-of-eight pattern for 30 seconds. 
Then polish the electrode on a wet BUEHLER Microcut SiC Grinding paper for metallography wet or dry (P4000) in similar figure-of-eight pattern, until a shiny mirror like surface is obtained. 
Wash the electrode with distilled water, and install in the cell system. 
The polishing should be carried out manually or with a polishing machine. If manually polishing is carried out, use as much force as possible, forcing the electrode towards the polishing paper and polish in a figure-of-eight pattern. The electrode surface could advantageously be inspected in a microscope.

Testing the glassy carbon electrode (ATMS-GC)

For differential pulse voltammetry use the following procedure; 
Insert the electrode together with the two other electrodes (counter electrode of platinum and reference electrode of Ag / AgCl) in a fresh nitric acid (0.01 M) solution added sodium chloride (0.01 M). 
Use a scan with 120 seconds deposition time at -600 mV, scan rate of 15 mV/s and a modulation pulse of 50 mV. End potential should be +50 mV. 
After repeating this scan five to ten times, the background current should stabilize and a stable base line should be obtained. 
After a steady base line has been achieved, add 25 ppb of lead and copper, and repeat the scan, now two peaks the first appearing at ~350 mV (Pb) and the other one at -50 mV (Cu) should be observed.
Wash the cell and electrodes in distilled water, and fill the cell with a fresh nitric acid (0.01 M) solution added sodium chloride (0.01 M) again, and repeat the scan. No peaks should be observed.

**Storing of the working electrode (WE) and the counter electrode (CE)**

The WE and CE are stored dry if not in use. For short-time storage, the electrodes are stored in clean water. After longer time storing in air, the working electrode should be polished as described above.

**Storing and maintenance of Ag/AgCl reference electrode (ATMS-Ag/AgCl-ref)**

The reference electrode should be stored in 3 M KCl if not in use. Once every fourth week, new freshly made KCl solution (3 M) should be refilled on the electrode. Several scans should be carried out afterwards to stabilize the electrode. Inspect the connection between the electrode and the cable; remove any deposits to securing good electrical contact.

**Making of supporting electrolyte for mercury measurements together with ATMS-AuBi electrode**

Use a graduated flask of 1 L.
Transfer 55 mL HNO₃ (concentrated) carefully to the graduated flask (Warning! HNO₃ is a strong oxidizing acid).
Fill up with distilled water to 800 mL
Add 45 g NaCl
Mix well and add distilled water to mark.

**Making of NH₄Cl supporting electrolyte for measurements together with ATMS-DAM and other electrode**

Use a graduated flask of 1 L.
Add 700 mL of distilled water.
Add 135 g of NH₄Cl salt
Mix well and add distilled water to mark.

Alternatively
Use a graduated flask of 1 L.
Transfer 80 mL HCl (concentrated) carefully to the graduated flask (Warning! HCl is a strong acid).
Add approximately 700 mL of distilled water
Titrate with NH₃ (1:1 with distilled water) to pH 6.4 or any other wanted pH.
Mix well and add distilled water to mark.

**Warning**
The above supporting electrolyte solutions is constructed for use in water matrixes close to drinking water. Any other solutions may need individual adjustment of the above supporting electrolytes, or other types of supporting electrolytes. Leave the supporting electrolytes stock solutions for at least one hour rest before use. Avoid any contaminants to enter the solutions. Containers which are used for storing supporting electrolytes should be labelled, telling clearly what chemicals are inside and left inaccessible for children or un-authorized personnel. Refer to individual datasheets for handling the actual chemicals. Always use protective clothing like gloves and protective spectacles.

**Regularly main maintenance Table for individual system**
### Maintenance

<table>
<thead>
<tr>
<th>Maintenance</th>
<th>Assumed frequency in drinking water</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange tubes; - Dosage pump supporting electrolyte - Peristaltic pumps</td>
<td>Every 8 weeks Every 6 months</td>
<td></td>
</tr>
<tr>
<td>New freshly made supporting electrolyte</td>
<td>Every 4 weeks</td>
<td></td>
</tr>
<tr>
<td>Voltammetric cell / electrodes (wash and polish)</td>
<td>Every 2 weeks</td>
<td></td>
</tr>
<tr>
<td>ATMS analyzer, calibration</td>
<td>Every 4 weeks</td>
<td></td>
</tr>
<tr>
<td>Check connectors to electrode interface</td>
<td>Every 4 weeks</td>
<td></td>
</tr>
<tr>
<td>Reference electrode Shift solution inside</td>
<td>Every 4 weeks Every 6 months</td>
<td></td>
</tr>
<tr>
<td>Shift tip (and reestablish AgCl layer)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interchange filling pump and draining pump</td>
<td>Every 6 months</td>
<td></td>
</tr>
<tr>
<td>Voltammetric cell</td>
<td>Every 12 – 24 months</td>
<td></td>
</tr>
</tbody>
</table>

### 6.4 The microprocessor card

All the electronics of the system is mounted on the microprocessor card. A picture of it is given in chapter 9.

Cell 1 is for normal use, cell 2 is for the additional electrode system ATMS 600D.

### 6.5 Troubleshooting

If the ATMS does not work properly, this might be due to the water system to be measured, the electrodes and their cables, the microprocessor card and the remaining devices in the unit.

For a service, the card can be disconnected and sent, by disconnecting the plug on it, the USB plug, the network cable and the three electrodes.

A simple control of the electrodes and their cables is to measure that it is not a broken electrical connection or a shortcut to the screening.

To control the remaining devices it is recommended to make a Troubleshooting without the card present, see Appendix D.

*If the voltammetric curve looks very unstable (saw-toothed) with several not reproducible peaks, like:*

![Graph of unstable voltammetric curve](image)

It is then recommended to control and clean the electrode system. Very often this is related to the reference electrode or missing electrical connection in the cell system or simply that the cell is empty. If the curve has very broad and high peaks, it is recommended to try with another working electrode as this might be due to a leakage to the inside of the electrode.
If the computer program (POS) does not “see” the measuring system. Here it is referred to chapter 5.3.1. The same port has to be used as for the previous measurement, otherwise the sensor will not be found. When the sensor is found, another of the communication ports can be selected.

The computer program (POS) can be used with all versions of the ATMS600, it is recommended to use the last version. It is also recommended to use the last version of the firmware for version 3 of the microprocessor card. For earlier versions of the microprocessor card, another firmware has to be applied.

6.6 Security

Since the supporting electrolyte is 100 times stronger than the finished solution in the voltammetric cell, precautions should be taken:
Don’t make more than 1 L of supporting electrolyte stock solution in the system (this both to avoid accidents and to avoid long time contamination of the solution)
Keep the supporting electrolyte in a secure labelled container with aeration
Always use protective clothing and protective spectacles when handling supporting electrolytes and standard solutions.
Refer to individual datasheets for any chemicals used in the system.
The equipment is powered with 12 V DC, any connection to higher voltage might be harmful for the equipment and the environment. If a 12 V DC adapter is used, this has to be marked with CE and □.

7 CALIBRATION AND RUNNING SETUP - EXAMPLES

7.1 Calibration setup

1. (Polish and install the silver based working electrode), add 29.45 mL of water and 300 microliter of ammonium chloride solution (2 M) to the cell (making a final ammonium chloride solution of 0.02 M). The working electrode should be placed as close as possible to the magnet (but not touching it).

2. Run a voltammetric scan using the parameters seen at the end of this chapter. Save the scan as "Blank.sxl".

3. Make a synthetic sample by adding 25 ppb of zinc (adding 250 microliter of a 3ppm zinc standard) to the solution in 1, and run a new scan. A zinc peaks should now appear (somewhere between -1100 and -900 mV. Save the scan as "Sample.sxl"

4. Add additionally 25 ppb of zinc to the solution in 3 and run a new scan. Save the scan as "Zn_added2.sxl".

You now have to scans, "Sample.sxl" and "Zn_added2.sxl". There are two ways to now use these scans as basis for putting calibration values in POS:
1. You could print out both scans and use a ruler to measure the height of the zinc peaks in millimetres in the individual print outs as shown below for one file.
2. You could use POS, by right click inside the POS window while having the scan file "Sample.sxl" or "Zn_added2.sxl" open and then selecting “Pick point” and “Enable”. Then you can use the cursor by left click on the right side of the Zinc peak (where it ends) and then left click on the top of the Zinc peak – and you can now read the peak height ($h_1$) in the lower part of the POS window under “Y-diff” (see the figure below).
Repeat the procedure for the second scan to find \( h_2 \) for "Zn50.sxl" scan. Then use the two values to calculate concentration of first scan (as this is a standardized experiment you know that the sample has 25 ppb and this should also be the value you find when you calculate – in a real sample you first run the sample itself and then add a known amount of standard solution to compute actual concentration in the sample and use this in “Metal Definition”).

From our example, let’s say that \( h_1 \) (which represents \( C_1 \)) is 7.12 microampere, than in a second scan after added additionally zinc we find \( h_2 \) to be 14.12 microampere. Now we put these two values into the expression for calculating \( C_1 \) (concentration in synthetic sample).
We get:

\[ \frac{250 \mu L \times 3000 \mu g/L}{[(14.12 \times 7.12) \times 30250 \mu L] - 30000 \mu L} = 25 \mu g/L \]

\[ C_1 \]

\[ C_2 \]

\[ h_2 / h_1 \]

\[ \text{Volume of sample (} V_0 \text{)} + \text{volume of added standard solution (} V_x \text{)} \]

C₂ will be C₁ + the added amount (which is 25 ppb also in this experiment) so C₂ is 50 ppb. Than we have h₁, h₂, C₁ and C₂. Now we can put these values into "Metal Definition" in POS as seen in the figure below. If you have a small peak for zinc in your “Blank scan” you can subtract this value in the h₁ and h₂ values to correct for blank.

In this example C₁ and C₂ are both known because we use a synthetic sample for the calibration. If we use a real sample, C₁ and C₂ can be calculated from the equations given above (also see chapter 5.3.4).
→ Save and continue with a new solution and next metal (e.g. lead).
Parameters used for calibration solutions up to 50 ppb:

PS: During calibration, always fill the cell manually with a measured volume of sample (use exact volumetric glassware for this), since exact volume is very important. Therefore Electrolyte volume and fill time (and drain time) is all put to zero!

7.2 Running setup

Perform as follows:
Make a new “Scan Profile” selecting “Profile/Scan Profile”
No ChartData loaded
Use the following scan parameters as indicated below and press “OK” (deposition time has to be selected due to concentration):

➔ Remember, deposition time has to be selected due to expected concentration for the metal present at highest concentration!

If the following dialogue box appears press “OK”
Your “Stop Pot” (stop potential) has now been updated to match a full scan sequence, and you can end the dialogue box “Scan Profile” by pressing “OK”.

Save this made Scan Profile as a file by selecting “File/Save As”
Select a name for the file (here indicated as “online”), and choose where to save the file in the MS Windows “Save As” dialogue box, and press “Save”.
Before continuing enter “File/Settings/Communication Settings”
Deselect all types of communications by deselecting all check boxes (green marks should not be shown at this stage). End dialogue box by pressing “OK”.
Run calibration routine for each individual metal as described in the previous chapter (7.2) before proceeding.

Open the file “online.sxl” created in the start of the document, and input values found for $h_1$, $h_2$, $C_1$ and $C_2$ for each metal in the “Metal Definitions” dialogue box.
➔ **IMPORTANT** – in the “Scan Profile” dialogue box be sure you use same value for “Dep. Time” as used in calibration!

After “Metal Definitions” dialogue box has been completed, save the file by pressing “OK”. The “online.sxl” file is now ready for automatic scan.
1. Enter “File/Settings/Communication Settings”

2. Check that all communications are disabled, except any you will like to use

IMPORTANT—set up of any communication needs expert configuration of individual parameters set by your local network administrator.
3. Enter File/Settings/General Settings
4. The dialogue box appearing will be “Settings”, inside this please press the gray square (“Path to store automatic generated files”).
5. Select an existing folder (here “A_Station_1”) or “Make New Folder”
6. After press OK and see that the selected or new made folder appears in the dialogue box.
7. Select the scan you will like to run automatically, by pressing “Add” in the “Scans to be run automatically” line.
8. Select the file from the location you have stored the file to be run automatically (initially created in this document), and press “Open”
9. Finally input “Cycle Time (min)” – normally 120 minutes, enable “Automatic scanning enabled” – and press “OK”.
The system will start first automatic scan after 120 minutes and continue a scan every second hour until it is stopped by entering “File/Settings/Communication Settings and disable “Automatic scanning enabled”. All scan files will be saved in a catalog named “Scans” as a subfolder in the created “A_Station_1” folder or any other selectable folder. Additionally, a txt file containing time and concentrations for calibrated metals will be generated. A new line will be written in this file each time a new scan has been ended.

8 APPLICATION NOTES FOR SOME COMMON METALS IN WATER

Except from the last application, the application notes below are worked out for pure solutions. Matrix effects might appear in natural systems.

The last application note is for a natural system (a river near a closed mining site) with copper iron and zinc. It is required to have in mind that this might not be directly applicable for other livers due to different matrix effects.

In the application notes, differential pulse voltammetry is applied. If it is wanted to use square wave voltammetry (which might give advantages like improved sensitivity and faster scanning), it is recommended that the routines are modified by using the same deposition potentials, end potentials and
deposition times as given in the application notes below. However, switch to the following values for the following parameters; Step Height = 10 mV, Squ. Amp 50 mV, Squ. Freq. 100 Hz. The figure below shows typical values for setting up Square Wave scan for zinc, lead, cadmium and copper in the range 10 – 50 ppb.

Typical set up parameters for scanning metals like zinc, lead, cadmium and copper in the range 10 – 50 ppb by use of Square Wave voltammetry.

**Application note ATMS-Cd**

<table>
<thead>
<tr>
<th>Purpose: Detection of cadmium (Cd(^{2+})) in pure drinking water</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Routine:</strong> 30 mL of water sample is added 300 µL of 2 M NH(<em>4)Cl (pH = 6.4) electrolyte solution, and analyzed by using DAM electrode. DPASV, (E</em>{\text{dep}} = -1000) mV, (E_{\text{start}} = -1000) mV, (E_{\text{end}} = -150) mV, Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s</td>
</tr>
<tr>
<td>Peak potential: (E_p) (C_d) (\approx -650) mV</td>
</tr>
<tr>
<td>Approximate detection limit in pure drinking water at deposition time 360 s; (C_{Cd} &gt; 5) µg/L</td>
</tr>
</tbody>
</table>
**Application note ATMS-Pb**

**Purpose:** Detection of lead (Pb$^{2+}$) in pure drinking water

**Routine:** 30 mL of water sample is added 300 µL of 2 M NH$_4$Cl (pH = 5) electrolyte solution, and analyzed by using DAM electrode. DPASV, $E_{\text{dep}} = -900$ mV, $E_{\text{start}} = -900$ mV, $E_{\text{end}} = -150$ mV, Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 10 s

Peak potential: $E_p \text{ Pb} \approx -500$ mV
Activation: No activation
Electrodes: W: DAM, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; $C_{\text{Pb}} > 1$ µg/L

**Application note ATMS-Zn**

**Purpose:** Detection of zinc (Zn$^{2+}$) in pure drinking water

**Routine:** 30 mL of water sample is added 300 µL of 2 M NH$_4$Cl (pH = 6.4) electrolyte solution, and analyzed by using DAM electrode. DPASV, $E_{\text{dep}} = -1450$ mV, $E_{\text{start}} = -1450$ mV, $E_{\text{end}} = -150$ mV, Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: $E_p \text{ Zn} \approx -1050$ mV
Activation: No activation
Electrodes: W: DAM, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; $C_{\text{Zn}} > 5$ µg/L

**Application note ATMS-Fe**

**Purpose:** Detection of iron (Fe$^{2+}$) in pure drinking water

**Routine:** 30 mL of water sample is added tri-sodium citrate to make 0.02 M electrolyte solution, and analyzed by using DAM electrode. DPASV, $E_{\text{dep}} = -1500$ mV, $E_{\text{start}} = -1500$ mV, $E_{\text{end}} = -150$ mV, Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: $E_p \text{ Fe} \approx -800$ mV

Approximate detection limit in pure drinking water at deposition time 360 s; $C_{\text{Fe}} > 2$ µg/L
### Application note ATMS-BiSens

**Purpose:** Detection of bismuth (Bi³⁺) in pure drinking water

**Routine:** 30 mL of water sample is added 300 µL of 2 M NH₄Cl (pH = 3) electrolyte solution, and analyzed by using DAM electrode. DPASV, \( E_{\text{dep}} = -650 \text{ mV} \), \( E_{\text{start}} = -650 \text{ mV} \), \( E_{\text{end}} = -150 \text{ mV} \), Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: \( E_{\text{p}} \text{ Bi} \approx -350 \text{ mV} \)

Activation: No activation

Electrodes: W: DAM, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; \( C_{\text{Bi}} > 10 \mu g/L \)

### Application note ATMS-TlSens

**Purpose:** Detection of thallium (Tl⁺) in pure drinking water

**Routine:** 30 mL of water sample is added 300 µL of 2 M sodium acetate (pH = 6.4) electrolyte solution, and analyzed by using DAM electrode. DPASV, \( E_{\text{dep}} = -1450 \text{ mV} \), \( E_{\text{start}} = -1450 \text{ mV} \), \( E_{\text{end}} = -150 \text{ mV} \), Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: \( E_{\text{p}} \text{ Tl} \approx -750 \text{ mV} \)

Activation: No activation

Electrodes: W: DAM, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; \( C_{\text{Tl}} > 15 \mu g/L \)

### Application note ATMS-MnSens

**Purpose:** Detection of manganese (Mn²⁺) in pure drinking water

**Routine:** 30 mL of water sample is added 300 µL of 2 M NH₄Cl (pH = 6.4) electrolyte solution, and analyzed by using DAM electrode. DPASV, \( E_{\text{dep}} = -1700 \text{ mV} \), \( E_{\text{start}} = -1700 \text{ mV} \), \( E_{\text{end}} = -150 \text{ mV} \), Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: \( E_{\text{p}} \text{ Mn} \approx -1450 \text{ mV} \)

Activation: No activation

Electrodes: W: DAM, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; \( C_{\text{Mn}} > 5 \mu g/L \)
### Application note ATMS-Cu<sup>Sens</sup>

**Purpose:** Detection of copper (Cu<sup>2+</sup>) in pure drinking water

**Routine:** 30 mL of water sample is added 300 µL of 2 M NH₄Cl (pH = 6.4) electrolyte solution, and analyzed by using Au-Bi electrode. DPASV, \( E_{dep} = -550 \text{ mV}, E_{start} = -550 \text{ mV}, E_{end} = -150 \text{ mV} \), Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: \( E_p \approx -250 \text{ mV} \)

Activation: No activation

Electrodes: W: Au-Bi, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; \( C_{Cu} > 1 \mu\text{g/L} \)

### Application note ATMS-Hg<sup>Sens</sup>

**Purpose:** Detection of mercury (Hg<sup>2+</sup>) in pure drinking water

**Routine:** 30 mL of water sample is added nitric acid and hydrochloric acid to total conc. 10 mM HNO₃ + 10 mM HCl, and analyzed by using Au-Bi electrode. DPASV, \( E_{dep} = -100 \text{ mV}, E_{start} = -100 \text{ mV}, E_{end} = 850 \text{ mV} \), Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 240 s and equ. time = 15 s

Peak potential: \( E_p \approx -550 \text{ mV} \)

Activation: No activation

Electrodes: W: Au-Bi, C: Pt R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; \( C_{Hg} > 1 \mu\text{g/L} \)

### Application note ATMS-Ni<sup>Sens</sup>

**Purpose:** Detection of nickel (Ni<sup>2+</sup>) in pure drinking water

**Routine:** 30 mL of water sample is added 1.5 mL ammonium buffer (buffer containing 0.1M HCl and 0.3M NH₃) to pH between 9 and 9.5, and 200µL of dimethylglyoxime solution (0.1M dimethylglyoxime disodium salt octahydrate), analyzed by using DAM electrode. DPASV, \( E_{dep} = -450 \text{ mV}, E_{start} = -450 \text{ mV}, E_{end} = -1300 \text{ mV} \), Scan rate = -15 mV/s, mod. pulse = 75 mV. Adsorption time 30 to 180 s and equ. time = 15 s

Peak potential: \( E_p \approx -850 \text{ mV} \)

Activation: No activation

Electrodes: W: DAM, C: Pt, R: Ag/AgCl

Approximate detection limit in pure drinking water at deposition time 360 s; \( C_{Ni} > 5 \mu\text{g/L} \)
**Application note ATMS-Co\textsuperscript{Sens}**

**Purpose:** Detection of cobalt (Co\textsuperscript{2+}) in pure drinking water

**Routine:**
30 mL of water sample is added 1.5 mL ammonium buffer (buffer containing 0.1M HCl and 0.3M NH\textsubscript{3}) to pH between 9 and 9.5, and 200µL of dimethylglyoxime solution (0.1M dimethylglyoxime disodium salt octahydrate), analyzed by using DAM electrode. DPASV, E\textsubscript{dep} = -750 mV, E\textsubscript{start} = -750 mV, E\textsubscript{end} = -1350 mV, Scan rate = -15 mV/s, mod. pulse = 75 mV. Adsorption time 30 to 180 s and equ. time = 15 s

Peak potential: Ep Co ≈ -1050 mV
Activation: No activation
Electrodes: W: DAM, C: Pt R: Ag/AgCl

**Approximate detection limit in pure drinking water at deposition time 360 s; C\textsubscript{Co} > 5 µg/L**

**Application note ATMS-Cu/Fe/Zn\textsuperscript{Sens} - automatic monitoring in a river system**

**Purpose:** Automatic monitoring of copper, iron and zinc in a natural river system

**Routine:**
The monitoring is performed automatically. 30 mL of river water is pumped into the voltammetric cell with automatic addition of 300 µL of 2 M NH\textsubscript{4}Cl as electrolyte solution, and analyzed by using DAM electrode. DPASV, E\textsubscript{dep} = -1450 mV, E\textsubscript{start} = -1450 mV, E\textsubscript{end} = -150 mV, Scan rate = 15 mV/s, mod. pulse = 75 mV. Deposition time 30 to 900 s and equ. time = 15 s

Peak potential: Ep Cu ≈ -250 mV, Ep Fe ≈ -800 mV Ep Zn ≈ -1050 mV
Activation: No activation
Electrodes: W: DAM, C: Pt R: Ag/AgCl

As this is a natural system and not a pure solution, matrix effects might appear

**Approximate detection limit in pure drinking water at deposition time 600 s; C\textsubscript{Zn} > 5 µg/L, C\textsubscript{Fe} > 5 µg/L, C\textsubscript{Cu} > 10 µg/L.**
9. Assembling of the ATMS 600 v3 and the LTMS

The ATMS consists of the following sub units:

- **Measuring cell** (in duplicate for ATMS 600D) with three electrodes and cables to be connected to the board card.
- **Microprocessor board** (card) v. 3. This is connected to the unit with a 26-pin plug, the three electrodes (or six electrodes for ATMS600D), USB-cable and IP-cable.
- The **26-pin plug** connects the board to the power and devices. Devices are (in duplicate for ATMS 600D): Two peristaltic pumps (one for filling and one for draining), magnetic stirrer, controller cable for N₂ bubbling, controller cable for dosage pump for adding electrolyte.
- Power connection (12 V DC or adapter from mains). One connection is for the board card and one is for the external. The two connections can be put together to one connection.

To remove the Microprocessor board (for service etc.); unplug the 26-pin plug and the three electrodes, the USB-cable and the IP-cable.

The Compact Flash Card (CF) on the board is for stand-alone storage of data. To facilitate the access to the CF Card, an option with a CF Card Slot outside the ATMS, by using an extender, is offered.

To upgrade the microprocessor board (card) to v. 3.0 from an earlier version, a cable to connect the 26-pin plug to the previously used 20-pin ATX-plug is available.

### Assembling of the glass cell measuring unit

The glass cell has outlet connection to a wide plastic tubing for water overflow (a), a thin plastic tubing (b) for automatic addition of supporting electrolyte via a dosage pump outside the ATMS instrument, and two tubings in the bottom for filling (c) and draining (d) of the cell via the filling and draining
persstaltic pumps. The c and d are connected to the outlet of the filling pump and the inlet of the draining pump, respectively. The e is air inflow above the overflow. The f is velcro for fastening the cell unit to the corresponding velcro on the back plate of the unit. The inlet of the filling pump is the tubing from the water source to be monitored. The outlet from the draining pump is connected to the drain outside the ATMS instrument (besides g). The same is also done with the overflow water (a). For calibration and other non-automatic use of the ATMS it is convenient to use a more simple measuring cell without inflow and outflow connections like:

The Microprocessor board (card) v. 3:
The connections to the 26-pin plug:

<table>
<thead>
<tr>
<th>RS232 GND:</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS232 GND:</td>
</tr>
<tr>
<td>RS232 TX (2):</td>
</tr>
<tr>
<td>For RS232 TX(1):</td>
</tr>
<tr>
<td>RS232 RX (2):</td>
</tr>
<tr>
<td>RS232 RX (1):</td>
</tr>
<tr>
<td>- to the card (SUPPLY GND):</td>
</tr>
<tr>
<td>+ to the card (SUPPLY IN):</td>
</tr>
<tr>
<td>ELL12/relay 5.2 (dospump1):</td>
</tr>
<tr>
<td>ELL11/relay 5.1 (dospump1):</td>
</tr>
<tr>
<td>Reserve Relay1:</td>
</tr>
<tr>
<td>Reserve Relay1:</td>
</tr>
<tr>
<td>Reserve Relay2:</td>
</tr>
<tr>
<td>Reserve Relay2:</td>
</tr>
<tr>
<td>ELL21/relay 10.1 (dospump2):</td>
</tr>
<tr>
<td>ELL22/relay 10.2 (dospump2):</td>
</tr>
<tr>
<td>Not in use:</td>
</tr>
<tr>
<td>CF1+/relay 2 (filling1):</td>
</tr>
<tr>
<td>CF2+/relay 7 (filling2):</td>
</tr>
<tr>
<td>N1+/relay 3 (gas1):</td>
</tr>
<tr>
<td>M2+/relay 9 (stirrer2):</td>
</tr>
<tr>
<td>M1+/relay 4 (stirrer1):</td>
</tr>
<tr>
<td>N2+/relay 8 (gas2):</td>
</tr>
<tr>
<td>CD1+/relay 1 (drain1):</td>
</tr>
<tr>
<td>+ external to relays:</td>
</tr>
<tr>
<td>CD2+/relay 6 (drain2):</td>
</tr>
</tbody>
</table>

For cable connections to the 26-pin plug, see Appendix A.5

*Polarity is very important for the magnetic stirrer. With wrong polarity it will not run and will be damaged after a short time.*

With wrong polarity the filling and draining pumps will not be damaged, but they will rotate in opposite directions.
If your LTMS is using a v2 micdoprocessor card, see appendix A7.

Flat 20-cable connection from the 26-pin plug, the LTMS 600v3 version (valid for all subversions):
**Plug up** *(c = card, s = stirrer, g = gas, ext. = external units)*

<table>
<thead>
<tr>
<th>Top:</th>
<th>2</th>
<th>4</th>
<th>6</th>
<th>8</th>
<th>10</th>
<th>12</th>
<th>14</th>
<th>16</th>
<th>18</th>
<th>20</th>
<th>22</th>
<th>24</th>
<th>26</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>3</td>
<td>5</td>
<td>7</td>
<td>9</td>
<td>11</td>
<td>13</td>
<td>15</td>
<td>19</td>
<td>21</td>
<td>23</td>
<td>25</td>
<td>+ext</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bottom:</th>
<th>1</th>
<th>3</th>
<th>5</th>
<th>7</th>
<th>9</th>
<th>11</th>
<th>13</th>
<th>15</th>
<th>19</th>
<th>21</th>
<th>23</th>
<th>25</th>
<th>+ext</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2</td>
<td>25</td>
<td>3</td>
<td>7</td>
<td>4</td>
<td>22</td>
<td>+stirrer</td>
<td>+g</td>
<td>+s</td>
<td>+g</td>
<td>+s</td>
<td>+g</td>
<td>+ext</td>
</tr>
<tr>
<td>Power to card</td>
<td>Power to external</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td>Power to card</td>
<td></td>
</tr>
</tbody>
</table>

*) common minus, also to chassis

The + is in centre in all plugs

The gas connection can also be used as a beeper to announce required manual action. Also see appendix E.
10 OPTIONS

10.1 Output of 4 - 20 mA

An optional package for the ATMS600 makes it possible to present the results in a 4 – 20 mA loop, this to be implemented in the installations of the user.

10.2 Warning systems

An optional package for the ATMS600 makes it possible to have an alarm if:

- given levels of concentrations are exceeded
- data transfer is missing
- operational breakdowns like electricity supply
- no water in the measuring cell (due to frost, tubes etc.)
- stability problems with the scans

The alarm is given with a sound, with SMS-messages, and/or with switch of relays (to be used for redirecting the water flow or any purpose wanted).

This alarm system can be installed on the ATMS600, or remotely on any PC with internet connection.

A APPENDICES

A.1 Quick start up guide for the ATMS 600 and the LTMS 600

- For the first use, install the program (POS) on the PC. See Chapter 5.
- Set up the system with the measuring cell with stirrer, and the three electrodes.
- Find the method to be used (from the application notes in the manual or elsewhere).
- For manual use, fill the cell with the solution to be measured and add the supporting electrolyte.
- Start POS and go to File→SA Sensor→Sensor Info. Use Cell1 for single cell systems and control the relays (for manual systems (LTMS) only Agitation (stirring) will work). Use USB and Exit.
- Then, still in POS, go to Profile→Scan Profile→General Settings and select the actual parameters according to the procedure used.
- Then, still in POS, go to Scan→Start.

After being familiarized with the first steps, automatic runs, calibration etc. is carried out according to the manual.

For more information we refer to the manual:
http://www.sensqua.com/download/
A.2 Calculations

In chapter 5.3.4, with an example given in chapter 7.1, a calibration for a metal is performed by measuring two peak heights \((h_1\) and \(h_2\)). Initially the solution in the measuring cell has the volume \(V_0\), and a given volume \(V_x\) of a standard solution with the concentration \(C_x\) is added. This enables one to calculate the two concentrations \((C_1\) and \(C_2\)) from

\[
C_1 = \frac{C_x \times V_x}{h_2} \left(\frac{V_0 + V_x}{V_0}\right) - \frac{V_0}{h_1}
\]

and

\[
C_2 = \frac{C_x \times V_x}{h_2} \left(\frac{V_0 + V_x}{V_0}\right) - \frac{V_0}{h_1}
\]

Then the obtained values (peak height current \((h_1 = \text{Current 1})\) and the corresponding concentration \((C_1 = \text{Conc 1})\)) and (peak height current \((h_2 = \text{Current 2})\) and the corresponding concentration \((C_2 = \text{Conc 2})\)) are inserted into the “Metal Definition Table”.

We have found it not convenient to include the above calculation in POS itself, this is easier by using a calculator, or better with a small programmable calculator. A useful programmable calculator is HEXelonMAX. This can be free downloaded from www.HEXelon.com After downloaded, calculation of \(C_1\) and \(C_2\) can be programmed by pressing “Functions” and define the functions \(C1\) and \(C2\) as given below.

![Calculator screenshot](image)

The value of \(C_1 = \text{Conc 1}\) and \(C_2 = \text{Conc 2}\) are computed with the command \(C1\) or \(C2\) respectively, using the format \(C1(Cx;V0;Vx;h1;h2)\) or \(C2(Cx;V0;Vx;h1;h2)\). The computed value can be copied directly into the Metal Definition Table.

With the example in chapter 7.1, this gives:
A.3 Remote control

For assistance it is convenient remotely to control the ATMS-measurements by “taking over” the remote computer. This can be done by installing the free software Teamviewer: [http://www.teamviewer.com/download/index.aspx](http://www.teamviewer.com/download/index.aspx). Then it is possible to "take over" the computer for diagnostics with the running of ATMS. Teamviewer generates an ID-number to reach your computer and a password, and we will need both to "take over" (to protect the privacy, the password changes each time you restart the computer).
A.4 Flow data for the peristaltic pump 400/F/M1 (W-M Alitea)

The data below are from the manufacturer of the pump. However, a calibration is required if the flow rate is used to calculate dilution factors. This calibration is performed by measuring the volume after a given time under similar conditions as being used for the actual monitoring. [An example of some calibration data measured by our company is given in brackets]. If a dosage pump is used, such a calibration is not required.

<table>
<thead>
<tr>
<th>Speed rpm</th>
<th>0.5 mm</th>
<th>0.8 mm</th>
<th>1.6 mm</th>
<th>2.4 mm</th>
<th>3.2 mm</th>
<th>4.0 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>0.12</td>
<td>0.36</td>
<td>1.32</td>
<td>2.9</td>
<td>4.9</td>
<td>7.1</td>
</tr>
<tr>
<td>40</td>
<td>0.4</td>
<td>1.2</td>
<td>4.4</td>
<td>9.6</td>
<td>16</td>
<td>23</td>
</tr>
<tr>
<td>100</td>
<td>1.00[1.92]</td>
<td>3.0[3.13]</td>
<td>11</td>
<td>24</td>
<td>41</td>
<td>59*[35.2]</td>
</tr>
<tr>
<td>200</td>
<td>2.0</td>
<td>6.0</td>
<td>22</td>
<td>48</td>
<td>82</td>
<td>118</td>
</tr>
</tbody>
</table>

*: Standard for the pumps inside the ATMS

A.5 Wiring changes of the ATMS Flat 20-cable connection

For wiring after 1. March 2016 proceed to A.5.3

A.5.1 Flat 20-cable connection from the 26-pin plug, dual cell version, valid for installations before July 2014:

Connection between the 26-pin plug and the 20x0.5 mm² flat cable:

<table>
<thead>
<tr>
<th>Plug</th>
<th>8</th>
<th>25</th>
<th>7</th>
<th>9</th>
<th>10</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>c+</td>
<td>ext+</td>
<td>c-</td>
<td></td>
<td>ext-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>cell 1</td>
<td></td>
<td>cell 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*: interconnect to ext-

The microprocessor card is connected with an orange 26-pin plug:
In red: only connected for the single cell version (flat cable No)
In green: additional connections for the dual cell version (flat cable No)

Up (c = card, dos = dosage pump, f = filling, d = draining, s = stirrer, ext = external units)

<table>
<thead>
<tr>
<th>2</th>
<th>4</th>
<th>6</th>
<th>8</th>
<th>10</th>
<th>12</th>
<th>14</th>
<th>16</th>
<th>18</th>
<th>20</th>
<th>22</th>
<th>24</th>
<th>26</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>7</td>
<td>dos1</td>
<td>dos1</td>
<td>dos2</td>
<td>dos2</td>
<td>dos2</td>
<td>dos2</td>
<td>dos2</td>
<td>dos2</td>
<td>dos2</td>
</tr>
</tbody>
</table>

Interconnection of – power to

| 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 |
|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|
**External:**

This gives for the flat cable:

| 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 |
| + power to card | + power to card | - power to external | - power to external | Dosage pump 1.1 | Dosage pump 1.2 | + fill 1 | - power to external | + stirrer 1 | - power to external | Dosage pump 2.1 | Dosage pump 2.2 | + fill 2 | - power to external | + stirrer 2 | - power to external | not in use | not in use | not in use | not in use |

Cable colours:

From here, the flat cable is divided and connected to the actual external units

*For normal use 1+2 as well as 3+4 are interconnected to the same power supply

**Connecting sequence (for easy mounting):** Interconnect 4, 8, 11, 15 and 18. Then connect cables to bottom of the plug: 2, 3, 5, 12, 14 and 17. Then connect cables to top of the plug: 1, 6, 7, 9, 10, 13 and 16.

**Flat cable connection, single cell version:**

This has the same connections as above, but flat cables 1 – 11 are connected only.

Other connections are also possible, for gas bubbling, RS232 etc.

**NB!** For all v.3-cards, all the wirings are the same from the yellow 26-pin plug TO the card. This means that any v.3-card can be changed without wiring conflicts.

The changes indicated below is for connections from the yellow 26-pin plug TO the components only.

**A.5.2 From the 26-pin plug after July 2014, but before March 2016:**


The unit has two fuses, a general one (on the outside panel) and on the card.

**Plug up** (c = card, dos = dosage pump, f = filling, d = draining, s= stirrer, ext = external units)

<table>
<thead>
<tr>
<th>Top:</th>
<th>2</th>
<th>4</th>
<th>6</th>
<th>8 c+ (1)</th>
<th>10 dos1 (6)</th>
<th>12</th>
<th>14</th>
<th>16 dos2 (14)</th>
<th>18 f1 (7)</th>
<th>20</th>
<th>22 s1 (11)</th>
<th>24 d1 (9)</th>
<th>26 d2 (17)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>7 c- (3)</td>
<td>9 dos1 (5)</td>
<td>11</td>
<td>13</td>
<td>15 dos3 (13)</td>
<td>19 f2 (15)</td>
<td>21</td>
<td>23 ext+ (2)</td>
<td>25</td>
<td>27</td>
<td></td>
</tr>
</tbody>
</table>

B. plus power

**Interconnection of + and - power to external (no plug connection)**

| 4 | 8 A. minus power | 12 | 16 | 19 |

79
This gives for the flat cable (26-pin plug No). **Bottom on the plug is underlined:**

| Flat cable: | Plug: | 1* | 2* | 3* | 4* | 5  | 6  | 7  | 8  | 9  | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 |
|-------------|-------|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
|             |       | +  | +  | +  | -  |   | -  |   | -  |   | +  | +  | +  | +  | -  | +  | +  | +  | +  | -  |
| Top         |       | card | card | card | pump | card | pump | card | pump | card | pump | card | pump | card | pump | card | pump | card | pump | card |
| Bottom      |       |     |     |     |     |     |     |     |     |     |     |     |     |     |     |     |     |     |     |     |     |

Cable colours:

From here, the flat cable is divided and connected to the actual external units.

*For normal use 1+2 as well as 3+4 are interconnected to the same power supply

**A.5.3 After 1. March 2016:**

The wiring with flat cable from the orange (on some cards it is black) plug on the card connects to the different units inside the plastic cabinet (like magnetic stirrer, pumps, light) and the electrical connections to the outside (power supply, USB, TCP, dosage pump, fuse).

See **below for installation outside the plastic cabinet.**

**Actual connections to the 26-pin (Weidmüller) connector on the card (for all versions):**

(c = card, dos = dosage pump, f = filling, d = draining, s = stirrer, ext = external units) Seen from the side of the cables. The circles are the colors of the connected cables.

The top is without grooves (rifler), in contrast to the bottom. For the ATMS600, the dos2, f2, s2, and d2 (marked green) are not used.

<table>
<thead>
<tr>
<th>Top</th>
<th>2</th>
<th>4</th>
<th>6</th>
<th>8</th>
<th>10</th>
<th>12</th>
<th>14</th>
<th>16</th>
<th>18</th>
<th>20</th>
<th>22</th>
<th>24</th>
<th>26</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>3</td>
<td>5</td>
<td>7</td>
<td>-card</td>
<td>-card</td>
<td>dos1.1</td>
<td>dos2.2</td>
<td>dos1.2</td>
<td>dos2.1</td>
<td>dos1.1</td>
<td>dos2.2</td>
<td>dos1.2</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>(3)</td>
<td>(6)</td>
<td>(14)</td>
<td>(14)</td>
<td>(12)</td>
<td>(13)</td>
<td>(5)</td>
<td>(5)</td>
<td>(15)</td>
</tr>
</tbody>
</table>

This gives for
Top: with the 20-cable flat cable.
Bottom: with the 26-pin plug No (bottom on it is underlined), A and B are not connected to the flat cable.
From the flat cable to the plug to this connector:

<table>
<thead>
<tr>
<th>Cable Card</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8</td>
<td>25</td>
<td>7</td>
<td>A</td>
<td>10</td>
<td>18</td>
<td>A</td>
<td>24</td>
<td>B</td>
<td>22</td>
<td>A</td>
<td>15</td>
<td>16</td>
<td>19</td>
<td>26</td>
<td>B</td>
<td>21</td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ power to card</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>- power to ext, not via card</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Dosage pump 1.1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Dosage pump 1.2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ fill 1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>- drain 1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ power ex. (from 2 for light)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>- power to external</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Dosage pump 2.1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Dosage pump 2.2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ fill 2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>- power to ext</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>- drain 2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ power ex. (from 2 for light)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ stirrer 2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ power to ext</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>+ power to card</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power*</th>
<th>dos 1</th>
<th>Switch</th>
<th>fill/drain1 + lamp</th>
<th>In pumping box</th>
<th>Stir 1</th>
<th>Stirrer</th>
<th>dos 2</th>
<th>Switch</th>
<th>Fill/drain2 + lamp</th>
<th>In pumping box</th>
<th>Stir 2</th>
<th>Stirrer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

From here, the flat cable is divided and connected to the actual external units

*For normal use 1+2 as well as 3+4 are interconnected to the same power supply.

For the **single instrument** (ATMS600), the cables: Dos2, Fill/drain2 + lamp and Stir2 are not connected. All actual As are interconnected.

For the **double instrument** (ATMS600D), all the five As = -ext (flat cable No 4, 8, 12, 16 and 20) are interconnected,

For the **double instrument** all the five As = -ext (flat cable No 4, 8, 12, 16 and 20) are interconnected, but not connected to the plug. Both the Bs = +ext (flat cable No 10 and 18) and flat cable No 2 are interconnected, and connected to No 25 on the plug (to be controlled by the relays to switch connections to the external units).

For the **single instrument**, remove all the flat cables from 13 to 20 and their connections.

For normal use, flat cable 1+2 as well as 3+4 are interconnected, using the same power supply. This means that the power to the card and to the external units (stirrer, pumps etc.) both come from the same power source.

**For installation outside the plastic cabinet.**

- Plus (+) on the power supply for the card is connected to the flat cable pos. 1
- Minus (-) on the power supply for the card is connected to the flat cable pos. 3
- Plus (+) on the power supply for the external units is connected to the flat cable pos. 2
- Plus for the dosage pumps, fill and drain pumps and magnetic stirrers are connected according to the table above
- Minus (-) on the power supply for the external units is not connected to the flat cable, but as the joint minus (–) for the dosage pumps, fill and drain pumps and magnetic stirrers
- The dosage pumps are connected according to the table above
- *For normal use with stable voltage 1+2 and 3+4 are interconnected to the same power supply
A.6 Troubleshooting without the card present (also see Chapter 9)

- Unplug and remove the card.
- Ensure which version is used for the connection: If position No 19 and 20 on the flat cable both are connected to the orange (on some cards it is black) plug, it is after March 2016. If they both are not, it is before July 2014. If No 19 is connected and 20 is not, it is between July 2014 and March 2016.
- Power the ATMS, the lamp(s) should then be on.
- Connect plus 12 V from the power supply to the orange plug positions No 18, 24 and 22 (and 19, 26 and 21 for the dual cell) and control that the different functions work properly.

A.7 LTMS with a v.2 card

THE LTMS is a simplified version of the automatic ATMS, with manual filling and draining:

ELL1 (electrolyte): Dosage Pump, Cell 1
CD1: Cell Drain (pump), Cell 1
CF1: Cell Fill (pump), Cell 1
N1: N₂ bubbling, Cell 1
M1: Magnetic stirrer, Cell 1
NA1: Not in use, Cell 1

ELL2 (electrolyte): Dosage Pump, Cell 2
CD2: Cell Drain (pump), Cell 2
CF2: Cell Fill (pump), Cell 2
N2: N₂ bubbling, Cell 2
M2: Magnetic stirrer, Cell 2
NA2: Not in use, Cell 2

For all plugs, the + is in the centre.
For the LTMS with this card, we have the following wiring:
/ = +12 V (all those are interconnected on some cards). / = -12 V. / = to stirrer via the corresponding relay. / = to gas via the corresponding relay.
The gas-output is normally not used with the LTMS and this connection might be applied for operating a buzzer or a light signal as reminder for manual actions like filling and draining of the measuring cell, this being programmed in POS. Plugs for this purpose are available from SensAqua.
Mounting the cell:
The fill pump is on the left side and the drain pump is on the right side, both are rotating clockwise as standard. For clarity, the tube for electrolyte is shown in front, please mount the cell with this behind.
A is connected to the outlet from the left side of the draining pump to the draining outside the unit.
B is connected to the sample inlet and to the right side of the filling pump.
The two transparent tubes are connected to the two other inlets on the two pumps.

Cell with water inlet and outlet, and addition of electrolyte for fastening